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_______________________________
1  Introduction_______________________________

The Michigan Department of Transportation is facing many management challenges due to the
growing responsibility for expanding, improving and maintaining a highway system that includes over
9,500 roadway miles.  These responsibilities are affected by:

C Business Process Redesign

C Increased Federal requirements to meet schedules

C Product delivery demands

C Increased funding with a limited work force

In recognition of these ongoing challenges, the Department has implemented a new system to assist
managers in the management of construction phases of MDOT jobs.

This manual provides a working-level description of that system: the Construction Scheduling System
(CSS).  It describes how the information system is used by M!DOT Project Managers, Program Managers
and Organizational Unit Managers to assist in planning, scheduling, budgeting, and controlling construction
jobs in the Department's highway program.  CSS is an automated planning and scheduling tool, tailored to
the M!DOT business process.  It is designed to allow department personnel to be most productive and
effective in managing the planning, design and right of way activities of the Department's highway program
from both short and long-term perspectives, reflecting the Department's priorities in a world of funding
constraints and rapidly changing funding requirements.

The CSS application is a customized software solution for scheduling, reporting progress, and tracking
status of jobs, built upon the Control and Analysis Tool (CAT) developed by Robbins-Gioia, Inc. 
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______________________________________________________________________________________
General Features
______________________________________________________________________________________
The CSS application simplifies the process of program management by providing an integrated database
with a variety of analysis and reporting functions. CSS provides you with the following:

C Multi-user access to enable two or more users to operate within a program environment
simultaneously.

C A fully menu-driven environment to guide you through the process of defining work and
updating and reporting program status.

C An extended network capability, which enables you to link networks in large, modular
programs.

C A network generator which will automatically generate a job schedule using a generic
template network and a set of characteristics which define the job's scope and create a
tailored activity network specific to each job.

C An earned value analysis function, which ensures valid comparisons between planned and
accomplished work.

C Macro utilities, which enable you to customize data entry screens, gantt charts, diagrams,
and reports. ( This is handled by the system administrator) 

C The capability to perform "what-ifs" by varying the job's characteristics easily and quickly
and/or making changes to the network without impacting the original network.

C Work Breakdown Structure (WBS), Organization Breakdown Structure (OBS), and actuals
accounting information which is integrated with your program data.

C Data entry screens and reports which enable Project Managers working with Organizational
Unit Managers to refine networks before approval and incorporation into the authorized
Program Area of the system.

C Security and access permissions which manage the review and approval mechanisms
throughout the application.

C Fully integrated menu structures for the above development tasks.

In addition, CSS has the capability to import other program information from other software applications.

The CSS is simple to use because of its easy-to-understand menus and on-line assistance that can walk a
user through the procedures necessary for managing a job, yet it is powerful enough to provide advanced
analytical tools that supply critical information for informed decision making.  Whether a user is a novice
or an experienced project planner, the CSS will equip the user with the capability to manage projects with
ease, flexibility, and power.
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______________________________________________________________________________________
Application Structure
______________________________________________________________________________________

For each program you specify, the CSS application establishes a separate working area, or project
environment.  Within the environment, you can define, schedule, and budget the work associated with
that program.

When you create a new project environment, you define it by specifying the elements that make up your
program. These elements include:

C Precedence logic networks

C Resource specifications, availabilities, and requirements

C Work breakdown structures (WBSs)

C Organizational breakdown structures (OBSs)

C Actual accounting 

C Earned value methodology 

C Calendars

When you define the CSS working environment, you assign unique names to the elements.  You can then
enter project data, conduct analysis, and generate a variety of reports and graphs to review project status.

CSS links elements of a program environment interactively; changes you make in one area cause changes in
related areas. For example, each activity’s resource requirements are associated with resource specifications
and availabilities.  Each activity in turn may be associated with a WBS or OBS element. These associations
enable you to:
 

C generate network activity schedules based on resource requirements and availability.

C report total cost using resource specifications entered for the corresponding resources.

C cross-reference network activities with WBS, OBS, and actuals accounting elements, which
provide the information for program reports.

Each element of the program environment is described here.
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_________________________________________________________________________
Networks

A network consists of the activities or task necessary to complete a project, as well as the constraints or
dependencies that logically connect those activities in the order that they can be accomplished. CSS will
support networks with an unlimited number of activities and constraints.

You can create a network by entering a minimal amount of data for each activity (activity code, description,
and duration) and constraint (preceding and succeeding activity codes).  You can modify the network
schedule by entering such information as activity delays, planned start and finish dates, or forced start dates
for selected activities.

When you have developed a satisfactory plan for your network, you can baseline the project.  This enables
you to compare schedule changes to the original plan.

Once the program is underway, you can enter schedule status information such as actual start and finish
dates and the percentage of completion of each network activity.  By analyzing the network, you can
determine the overall schedule status and report variances against the baseline.  
_________________________________________________________________________
Resources

For each program, you can identify the resources- people, money, and materials- necessary to complete the
work.  By using codes you define for each resource, you can easily specify resource, specifications,
availabilities, and requirements.

Resource specifications designate basic and overtime rates entered for each labor resource in dollars per
hour.  CSS calculates a budget for each activity and reporting level (WBS and OBS) based on the
specification information.

Resource availabilities specify how much of and how long a particular resource is available for use. 
Resources can be renewable, such as labor or consumable, such as materials. Analysis of availabilities
information determines whether and how activities can be scheduled to complete all project work.

Most network activities have specific resource requirements.  Each requirement identifies the per-period
quantity of the resources required to complete the activity.
_________________________________________________________________________
Work Breakdown Structure

Work breakdown structures (WBSs) provide program managers with a top-down approach to program
planning and task integration.  Managers can use a WBS to present and track individual tasks and assign
management and technical responsibilities for a program.

A WBS is a hierarchical structure, similar to a company organizational chart.  Each level of the WBS
represents a successively lower breakdown of the deliverable item(s) to be developed for the project. A
WBS represents the deliverables (products and services) for the program rather than the actual work
performed during the program.
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______________________________________________________________________________________
Organizational Breakdown Structures

Organizational breakdown structures (OBSs) are similar to WBSs, except that an OBS is identical to a
company organizational chart.  An OBS defines a top-down hierarchical structure of the organization or
work group performing the network activities.  You can use an OBS to assign organizational
responsibilities for each activity and resource.

_________________________________________________________________________
Earned Value

Earned value is a measure of work performed in terms of budgeted cost.  It helps you to find potential
problems early in a program’s life when many alternatives are workable. To perform earned value analysis
in CSS, you must enter data in a number of screens.

You need to use all the options from the Define Program Environment menu to establish earned value
capability.  In the Program Environment data screen, you must specify a WBS Relationship, Earned Value
Analysis Start Date, Reporting Period, and Default Methodology.  Additionally, you must create one or
more networks, resource availability tables, and calendars.

Use the Enter or Modify Information menu to enter resource specifications, availabilities, and requirements. 
By comparing this resource information with the actual data, you can track the efficiency of your plan.  You
must specify calendars for resource availabilities and requirements.  Otherwise, the continuous calendar 0 is
the default.  This calendar does not take holidays, rest days, and other interruptions into account, which may
skew you earned value calculations.

Use the Enter or Modify Information menu to access the Enter or Modify Activities option.  You must
specify a calendar for each activity.  You must also specify a WBS code, which is used as a charge code, for
each activity.

_________________________________________________________________________
Calendars

To schedule program work, you can define up to 90 different calendars.   For example, you can schedule
program activities using a calendar with five eight-hour working days and two rest days (such as Saturday
and Sunday) each week.  Alternatively, you can use calendars with seven working days or round-the-clock
shifts to meet specific program requirements.

CSS has several predefined calendars to choose from.  You may copy and modify these calendars as
needed.
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_________________________________________________________________________
Analysis Functions
______________________________________________________________________________________
After you enter program data, you can use the CSS application to conduct a series of analysis functions on
the data.

C Activity time analysis validates the logic of the network and calculates values such as early
start and finish dates and float value.

C Resource scheduling further modifies the calculated values by scheduling activities based
on specific resource requirements and availabilities.  The scheduling process can be
constrained by time, when the finish date of the network is fixed and cannot slip, or resource
availability, when the finish date can be slipped to accommodate resource scheduling for an
extended network.

C Resource summarization compares resource requirements against the resource availabilities
during a period that you specify.

C Baselining monitors program progress by enabling you to compare the baselined- or original
schedule- dates with the dates recalculated as a result of updates. You can establish original,
revised, and intermediate baselines.

C OBS/WBS schedule roll-ups produce schedule and actual dates for each level of the WBS or
OBS established for the program.

C Actual hours summarization summarizes times and cost for resources to complete the
program.  The summarized data includes the available, required, and actual hours and/or
costs each resource uses or needs for program activities.

C Earned value analysis calculates earned & actual costs for the earned value reporting period.
_________________________________________________________________________
Reports and Graphs
______________________________________________________________________________________
The CSS application provides a variety of outputs, including:

C Administration listings of unprocessed data
 

C Program reports and graphs of the data entered for a program

C Network reports and graphs of analyzed and scheduled network data

C Resource reports and graphs of analyzed and scheduled resource data.

Reports and graphs can be displayed on your terminal screen, output as hard copy on printer or plotter, or
sent to files.  Reports and graphs can also be customized to include special reporting requirements for a
program.
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______________________________________________________________________________________
What If
______________________________________________________________________________________

You can use the What If option to make changes to a copy of your program.  The What If feature enables
you to evaluate the effects of these changes without altering the original program.

When you make What If changes to the current network, the changes are assigned to a network change
request (NCR).  Each NCR you define can be stored and recalled, enabling you to investigate alternative
plans without affecting the baseline program.

If you determine that any of the proposed changes should be incorporated into the original network, the
corresponding NCRs can be implemented into it.

When you use the What If, the same analysis, schedule, and reporting capabilities are provided, as well as
additional reports for review of the What If data.

__________________________________________________________________
Other Features of the CSS
______________________________________________________________________________

The CSS utilities enable you to perform “housekeeping” tasks such as importing and exporting data files
and customizing data entry screens, gantt charts, diagrams, and reports.  The utilities also provide functions
to display the status of the system output spooler, printers and plotters; display listing of directories and
users; and communicate with other CSS users.

Administration menu options enable an application administrator to customize the environment by
controlling user and data access, modifying field headers and formats, selecting and sorting reports and
graphs, deleting output files, packing CSS recordsets, and renumbering activities and constraints.

The CSS is simple to use because of its easy-to-understand menus and on-line assistance that can walk a
user through the procedures necessary for managing a job or multi-job project, yet it is powerful enough to
provide advanced analytical tools that supply critical information for informed decision making.  Whether a
user is a novice or an experienced project planner, the CSS will equip the user with the capability to
manage projects with ease, flexibility, and power.

The remaining sections of this manual will discuss in more detail, the many features of CSS.  If you have
any question or comments, please address them to your system administrator.
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_________________________________
2  CSS Motif and Basics_________________________________
This section provides a list of the typographical conventions used within this manual, an explanation of CAT
database concepts, information on using the Motif interface with CSS, and procedures for data entry and output.
If you have not used CAT previously, you should familiarize yourself with the information presented in this
section before using the CSS application for the first time.

______________________________________________________________________________________
Document Conventions
______________________________________________________________________________________

The following list provides the typographical conventions used in this manual.

<  >
The angle brackets are used to enclose the names of specific keys on the terminal keyboard, as
described below.

< Enter >

Means press the key labeled “Enter” on your keyboard. On some keyboards this key is labeled
“Return.”

When the word “enter” (without angle brackets) is given as an instruction in the text or an on-screen
prompt, type the information specified and press < Enter >.

< Ctrl-A >

Means hold down the Control key (usually labeled “Ctrl”) while simultaneously pressing the
alphabetical character key given.

< F1 >through< F9 >

Represent the Function keys of your keyboard. When a Function key is given as an instruction, press
the Function key identified by the number.

system output

System output appears in a special typeface that looks similar to the screen display and output of
many printers.
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_________________________________________________________________________
Database Concepts
______________________________________________________________________________________

Before you begin using CSS, you should become familiar with the database concepts used in CAT. A
database is a collection of related data organized to facilitate storage and easy access of that data. In CAT,
the data in the database is stored independently of the programs that process and manipulate the data. A
database is composed of data elements, records, recordsets, subrecords, and subrecordsets. The figure on
the next page and the following paragraphs explain the relationships among these items.

Data elements are the smallest units of stored data. Each data element contains a specific category of
information such as a person's name or social security number. Fields are the most commonly used data
elements in CSS.

A record is a group of logically related fields treated as a single unit. Automated records, such as those
created and maintained in CAT, hold the same kind of information manual file records hold. For example,
in a manual personnel filing system, a file record is created for each individual on the staff. Each record
contains information about a specific employee, such as his or her name, social security number, and home
address.

A recordset is a collection of records containing the same set of fields. CSS treats these records as a
collective unit. For example, a recordset of a personnel database consists of the employee records and
subrecords created for every employee.

A subrecord  is similar to a record: it contains groups of related fields. A record may have one or more
subrecords. When subrecords are used, the record contains information common to all of its subrecords.
The subrecords contain specific information related to the main record with which they are associated. A
subrecord can generally be accessed only through its main record.

For example, in a personnel database the employee record is the main record. Each employee could have a
series of payroll subrecords, containing fields for pay rate, hours worked, and pay date. CAT associates
each payroll subrecord with the employee record containing the fields for the employee's name, social
security number, and address. By creating these subrecords, you only need to supply and maintain the
general information common to all the subrecords in one place: the employee record.

A subrecordset is a collection of subrecords containing the same set of fields. CAT treats these subrecords
as a collective unit. Although a record can have multiple subrecords, each recordset can be defined with
only one subrecordset. For example, each employee record can have many payroll subrecords; however, the
employee recordset can be associated with only one payroll subrecordset.
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________________________________________________________________
CSS and Motif
________________________________________________________________

The CSS application runs under the Motif interface to the X Window system. This means that CSS can be
accessed and used from within a window on a system running X and Motif.

Motif controls the operation and appearance of the windows on a terminal. This following pages describe
how to work in Motif and use the windows, menus, and other interface features to effectively use CSS.

______________________________________________________________________________________
Using the Mouse

The mouse is an input device attached to your terminal which is used with the X Window system. It is a
fast, easy way to interact with the system. Moving the mouse moves the pointer on the terminal screen.
Pressing a mouse button when the mouse is positioned on a menu option or screen button activates that
option or button.

The pointer changes shape to indicate system status. When the pointer is in a window and available for use,
it is displayed as an arrow. If the system is processing, the pointer has an “hourglass” shape and cannot be
manipulated. If the arrow is in the grey background area of the terminal outside of a window, it is displayed
as an X.

The mouse has one, two, or three buttons. Within this manual, “the mouse button” refers to the left mouse
button unless another one is specifically stated.

The specific actions associated with using the mouse are described below.

C Press — Push the mouse button and hold it down. Pressing is often used to select an option.
Pressing is usually followed by the drag operation.

C Release — Let the mouse button back up after pressing it.

C Drag — Move the pointer while pressing the button. This action ends when the button is
released. Dragging is used to move an object or select a range of objects.

C Click — Quickly press and release the button without moving the pointer. Clicking is used
to select an object or to perform an action.

C Double-Click — Click twice in rapid succession without moving the pointer.
Double-clicking is also used to select an object or perform an action.
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_________________________________________________________________________
Windows

A window is a graphic way of representing a separate workspace on a terminal screen.

The X Window system can display multiple windows on your screen at one time. You can have one
window for data entry in CSS, another window to view a file, and additional windows to other CSS
options, different applications, or the terminal operating system. These windows often overlap so that only
the top one is fully visible, but you can move and resize the windows so that all are visible. You can work
in one window while information in other windows is processing.

Each window has the same basic structure and components. A sample window is shown below followed by
an explanation of the different areas.

C The client area is the main section of the window in which most tasks are performed. The
default client area is 80 x 24 characters, the same size as a regular PC screen. You can use
the resize functions to modify the size of the client area.

C The title area is the horizontal bar at the top of the window. It contains the title (a label for
the window contents), the Window menu, and the Maximize and Minimize buttons.

C The Window menu is the bar on the left side of the title area. Clicking on this with the
pointer displays a list of menu actions which control the window: move, size, minimize,
maximize, lower, and close.
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C The Maximize button is the large square on the far right side of the title area. Clicking on
this increases the size of the window so that it fills the terminal screen. Many secondary
windows will not have a Maximize button.

C The Minimize button is the small square on the right side of the title area, just to the left of
the Maximize button. Clicking on this button changes a window into an icon — a small
graphic indicating the window contents. This procedure is called “minimizing” or
“iconifying.” Any processes that were running in the window will continue to run after the
window has been minimized. Many secondary windows will not have a Minimize button.

C The Resize borders are the edges of the window. The border is divided into four corner
handles and four edge handles. The corner handle is the section at each corner; the edge
handles are the sections between the corners of the border. Dragging the Resize borders
resizes and reshapes the window. Dragging the corner handles changes both the length and
width of the windows; the edge handles change either the length or width. Many secondary
windows will not have resize borders. Windows without resize borders have thinner edges
than those with resize borders.

Multiple Windows

The X Window system can display several windows on the screen at one time so that you can view or work
with several things simultaneously.

When multiple windows are displayed, only one can be “active” at a time. The active window accepts input
and is generally the top window in a stack; it also has a different border color from the other windows.
Inactive windows may be processing information, but you cannot manipulate them until you make them
active.

The pointer controls which window is active. To make a window active, move the pointer to it and click.
When you do this the border colors of the windows will change. The border of the window you just made
active will become the “active window color.” The border of the window you just left will become the
“background window color.”

The pointer must be present in a window for it to be active. If you move the pointer out of an active
window, you can no longer enter information into that window. However, the border will still show the
“active window color” so when you move the pointer back in you don't need to click.
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______________________________________________________________________________________
User Interface Objects

The mouse can be used to manipulate five basic user interface objects in the Motif implementation of X
Windows. These objects are menus, push buttons, scrollbars, dialog boxes, and radio buttons and
checkboxes.

Menus

Menus display a list of options that can activate a process, set a toggle switch, or call another menu. The
initial menu in a Motif window is a menubar, which is a list of options in a bar at the top of the window,
just under the title bar. A menubar and its related menus are called a menu system or menu family. A menu
system consists of the following components: pull-down menus, cascade menus, command options, radio
buttons, and checkboxes.
A sample menu is shown below, followed by a description of its components.

C Pull-down menu — A vertical menu that drops from the menubar. Options in a pull-down
menu spawn cascade menus, execute commands, or act as toggle switches. If an option
spawns a cascade menu, the option will have an arrow displayed to its right.

C Cascade menu — A vertical menu that appears next to the option on a pull-down menu that
spawns it. The options in a cascade menu spawn cascade menus, execute commands, or act
as toggle switches. If an option spawns a cascade menu, the option will have an arrow
displayed to its right.

C Command option — An option on a pull-down or cascade menu that executes a command.

C Radio button — A diamond-shaped toggle switch in a menu or dialog box that enable you
to select one of a group of choices. Radio buttons are displayed in groups. Only one radio
button in a group can be ON at one time. A radio button is ON when the diamond is
indented or concave; a radio button is OFF when the diamond is convex.

C Checkbox — A square-shaped toggle switch in a menu or dialog box that enable you to
select one or more choices in a group. Checkboxes are displayed alone or in groups. Multiple
checkboxes can be ON at one time. A checkbox is ON when the square is indented or
concave; a checkbox is OFF when the square is convex.
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Operating a Menu with the Mouse
Use a mouse to display and manipulate menus and the other user interface objects. To select menu items:

C Place the pointer on an option in the menubar.

C Press the mouse button.

C A pull-down menu is displayed.

C Drag the pointer down the menu by pressing and holding the mouse button.

C Each item will be highlighted as the pointer passes over the item. If an option has a cascade
menu associated with it (as indicated by an arrow to the right of the option), click the button
on that option to display the cascade menu.

C To select an option from a pull-down or cascade menu, place the pointer on the item and
release the button.

C To remove the menu from the screen without selecting an item, move the pointer off the
menu and release the button.

Another way to manipulate the menu is to use to click on the menu name (instead of dragging the pointer).
When you access the menu this way, the menu stays visible even if you move the pointer away from it. If
the menu contains radio buttons or checkboxes, you will need to access the menu this way to be able to
toggle the radio buttons or checkboxes ON or OFF.

C Place the pointer on an option in the menubar.

C Click the mouse button.

C A pull-down menu is displayed.

C Move the pointer down the menu.

C Each item will be highlighted as the pointer passes over the item. If an option has a cascade
menu associated with it, the cascade menu displays as the pointer passes over that option.

C To turn a radio button or checkbox ON /OFF, click the pointer on the box next to the desired
option.

C The shading of the diamond or square changes to show the change in status of the toggle.

C To select an option in the pull-down or cascade menu, click the pointer on that item.

C The menu is removed and the option is executed.

C To remove the menu from the screen without selecting an item, move the pointer off the
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menu and click the button.
Operating a Menu Without a Mouse

Menus can also be controlled with mnemonic keys. Most menu options have a letter which is highlighted or
underlined. By pressing the < Alt > key simultaneously with the key for the underlined letter, that menu
item is selected. If a radio button is selected in this way, the status of the radio button changes from OFF to
ON, or vice versa.

Push Buttons

Push buttons are rectangular objects that can be used to activate a process. They are commonly found in
dialog boxes and in data entry and View File windows. Each push button has a label that identifies the
process that the push button performs.

Push buttons are used for actions that occur so frequently that it is helpful that they are displayed in the
window rather than hidden in a menu. For example, in data entry push buttons are used for the actions
performed by function keys in non-X versions of CAT.

Sample push buttons are shown below.

To activate a push button using a mouse:

C Place the pointer on the push button and click.

As the action is performed, the push button momentarily changes appearance and then
returns to its normal, convex status.

Push buttons often have mnemonic keys. As in menus, these keys are highlighted or underlined.
To activate a push button using the mnemonic key:

C  Press the specified character on the keyboard.

The action is performed.

Scrollbars

Scrollbars enable you to select an area of information to display when the information exceeds the size of
the window. Both vertical and horizontal scrollbars are provided so that you can move up and down
through the information, or from side to side when appropriate. Generally, you use scrollbars to move
through a list of items or a long text file.

The scrollbars are usually on the side or bottom of the window. A scrollbar is a narrow rectangle with
arrows at both ends and a slider in the middle. The full length of the scrollbar represents the total size of
the file (or list). The slider represents the displayed portion of the file, indicating its relative size and
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position.

The size of the slider corresponds to the percentage of the file that you can view in the window; the smaller
the slider the larger the file. The position of the slider in the scrollbar indicates the position of the displayed
portion of the file; when the slider is at the top of the scrollbar, the beginning of the file is displayed. As
you move through the file, the slider moves down the scrollbar.

The scrollbar can be manipulated by clicking or dragging the pointer to control your movement through the
file. The chart below describes the movement possibilities. Use the vertical scrollbar to move up and down
through the file; use the horizontal scrollbar to move left and right across the file.

Note: “Unit” is used as a generic term to describe the smallest increment of measurement in a window. For
example, in Screenform data entry a vertical unit is a record and a horizontal unit is a field. In a View File
window a vertical unit is a line and a horizontal unit is half a screen.
Vertical

TO MOVE: DO THIS:

Down one unit

Up one unit

Down a few units

Up a few units

Down continuously

Up continuously

Click on the down arrow

Click on the up arrow

Click above the slider

Click below the slider

Drag the slider down

Drag the slider up

Horizontal

TO MOVE: DO THIS:

To the right one unit

To the left one unit

To the right a few units

To the left a few units

To the right continuously

To the left continuously

Click on the right arrow

Click on the left arrow

Click to the right of the slider

Click to the left of the slider

Drag the slider right

Drag the slider left
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Dialog boxes

Dialog boxes are small windows that generally contain a message and/or a space for user input, as well as
one or more push buttons. Dialog boxes can be used to: display system messages; confirm a setting; select a
project; set a variable; and exit from data entry. There are four basic types of Dialog boxes: Message,
Prompt, List, and File Selection.

When a dialog box is displayed, you must respond to it before the system will continue. You will not be
able to interact with anything else on the screen until you respond to the box. If you move the pointer away
from the dialog box, the pointer displays as a circle with an arrow across it to remind you to respond.

Message Dialog Box

Message dialog boxes provide information, and usually contain a text message, an icon, and push buttons.
There are four types of Message dialog boxes:

C Help — Provides user information about a function. The OK push button, when selected,
returns control to the window that called the Help dialog box.

C Information — Provides a status message. It has an “i” icon and an OK button and can
include a Cancel button.

C Warning — Alerts the user to a possible problem. It has an “!” icon and push buttons for
OK and Cancel.

C Error — Displays an error message. It has a crossed-out circle icon and push buttons for
OK and Cancel.

Prompt Dialog Box

Prompt dialog boxes accept input from the user. This dialog box contains a message, a text input area, and
OK and Cancel push buttons. A sample Prompt dialog box is shown below.
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When a Prompt dialog box is displayed, you can either enter information or exit the box.
To enter a response in the Prompt dialog box:

C Move the pointer to the text input area in the dialog box and click.

C The text input area is highlighted to show that it is able to accept information.

C Enter the information in the text input area.

C Move the pointer to the OK push button and click.

The information is sent to the application for processing.

To exit a Prompt dialog box without saving any information entered:

C Move the pointer to the Cancel push button and click.

List Dialog Box

List dialog boxes contain a group of items from which you make a selection. These dialog boxes are often
used instead of pop-down menus in data entry and are often found in other areas. Depending on the number
of items in the list and the placement of the list on the screen, the List box may include vertical and
horizontal scrollbars. A sample List dialog box is shown below.

To select an item from a List box:

C Move the pointer to the desired item in the list and double-click.

The item you clicked on will be selected.
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File Selection Box

File Selection boxes contain a list of directories and files. These boxes are used to enable you to select a file
when you use the VIEW command without specifying a file, or from within View File if you select the New
or More options.

To use the File Selection box, select the directory which holds the file you want and then select the file you
want to display. The default file list contains the files in your current directory. To display a file that is not
listed, you can change the filter to the directory which contains the desired file.

The following is a description of the components of a File Selection box.

Boxes

C Filter — Specifies which files are displayed for selection, enabling you to shorten (or
lengthen) the list of available files. The Filter has a directory path name and can accept
wildcards.

C Directories — Lists the available directories.

C Files — Lists the files in the current filter.

C Selection — Specifies the name of the file selected for use in View File.

Push buttons

C OK — Executes View File and displays the file listed in the Selection box.

C Filter — Activates the filter box, making the directory listed in the filter box current.

C Cancel — Removes the box and returns to the previous window without selecting a file.

C Help — Provides information on how to use the File Selection box.

To select a file for display, follow the steps below.

To change the filter:

C Double-click on the desired directory name.
OR

C Click on the desired directory name and press <Enter>.
OR

C Click on the desired file, then on the Filter push button.
OR

C Click on the Filter box and type the name of the directory and press< Enter >, or click on the
Filter push button.
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The Filter box changes to reflect the new filter, displaying a different group of files.

To select a file:
C Double click on the desired file.

OR
C Click on the desired file and press < Enter >.

OR
C Click on the desired file, then on the OK push button.

OR
C Click on the Selection box and type the name of the file and press < Enter >, or click on the

OK push button.

The View File window displays the file specified.

To exit without selecting a file:
C Click on the Cancel push button.

The window from which you executed the File Selection box is redisplayed.

Checkboxes and Radio Buttons

Checkboxes and Radio buttons are toggle switches which are often used in menus or dialog boxes. A toggle
switch has two settings: ON and OFF. Radio buttons are diamond-shaped buttons followed by a label; only
one radio button of a group can be turned ON at a time. Checkboxes are square-shaped buttons followed by
a label; multiple checkboxes in a group can be ON at one time.

Radio buttons and checkboxes have a concave (indented) appearance when ON, and a convex (outdented)
appearance when OFF.

To turn a Radio button ON or OFF:

C Move the pointer to the Radio button and click.

The Radio button changes appearance (from convex to concave, or vice versa). All other 
Radio buttons in that group change to the opposite appearance.

To turn a Checkbox ON:

C Move the pointer to an OFF Checkbox and click.

The Checkbox changes to a concave appearance. The other Checkboxes do not change; 
any other ON Checkboxes remain ON.

To turn a Checkbox OFF:

C Move the pointer to an ON Checkbox and click.
The Checkbox changes to a convex appearance. The other Checkboxes do not change.
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______________________________________________________________________________________
Using the Window Menu

The Window menu displays a list of window actions which enable you to restore, move, size, minimize,
maximize, lower, or close the window. These options can be controlled with the mouse or through
accelerator or mnemonic keys, which enable you to manipulate the window more quickly or without a
mouse.

The options on the Window menu and described below with the corresponding accelerator keys (< Alt >
used in conjunction with a Function key). The mnemonic for each option is underlined. To use the
mnemonic, press the underlined letter key when the menu is displayed. The accelerator keys can be used at
any time independently of the menu.

Restore < Alt-F5 > 

Restores a maximized or minimized window to its normal size. This option is “ghosted” when the
window is in its normal state; it can be selected only when the window has been maximized or minimized.

Move< Alt-F7 >

 Moves a window around the screen. When you select this option, an image of the window is
displayed; use the pointer to move this image around the screen. When the image is in the desired location,
click the mouse button to position the window.

Size< Alt-F8 >

Changes the size of the window vertically, horizontally, or both at the same time. You can make a
window large enough to fill the screen or small enough to show only the Window menu button, the Title,
the Minimize button, and the Maximize button. When you select this option, “rubber-band” lines display to
represent the size and shape of the window. Move the pointer to move the rubber-band lines; when they are
in the desired position, click the pointer to resize the window.

Minimize< Alt-F9 >

Changes a window into an icon. Any processes running in the window continue to run after the
window has been minimized. Iconifying enables you to keep your workspace “clean” and work more easily
in other windows. To return a window to full size, use the Restore option on the Window menu or
double-click on the icon that represents that window.

 Maximize< Alt-F10 >

Enlarges a window to fill the screen. To return a window to its normal size, use the Restore option
on the Window menu.
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Lower< Alt-F3 >

Places the window at the bottom of the window stack. The window remains active, but you 
are able to view other windows. To return the window to the top of the pile, click the pointer on the visible
portion of that window. To make another window active, place the pointer on the desired window and click.

Close< Alt-F4 >

Closes a window and removes it from the workspace. Do not use this function to close the 
main CAT window; use the LOGOFF command instead.

Window Menu Shortcuts

The Window menu enables you to perform many basic windowing functions easily. However, as you
become more proficient with Motif, you can use Motif shortcuts to perform these actions more quickly.
These shortcuts are described below.

Moving the Window

You can move the window by dragging the title bar. To move the window:

C Place the pointer on the title bar.

C Drag the pointer.

C An image of the window moves with the pointer.

C When the window image is located at the position where you want to place the window,
release the button.

The window redisplays at its new location.

Changing the Window Size

Motif enables you to change the size and shape of the window. Note that when a window containing a text
file is made smaller, the text inside of it may seem truncated because the size of the text does not change.
Any “missing” text is redisplayed when you make the window larger. When you increase the size of the
window, you can enter information in any part of the window, but when you decrease the window size
some text may not be displayed.

However, when a window contains a graphics file, the graph is always sized to fit exactly in the window.
When you change the size of the window, the graph is reduced or expanded to fit the new size. The size of
any text fonts used in a graphics file change with the size of the window.

You can use the resize borders to change the size and shape of the window.When a border is dragged with
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the pointer, “rubber-band” lines outline the window shape. These rubber-band lines form a box anchored by
the original position of the window, but they stretch and move as the pointer is moved to illustrate the
possible window size. When you release the mouse button, the window resizes to fill the space described by
the rubber-band lines.

The edge handles and corner handles change the window size in different ways. Corner handles manipulate
the box size both horizontally and vertically. Edge handles manipulate window in only one direction; only
the sides perpendicular to the edge handle you selected move.

To change the size and/or shape of the window:

C Place the pointer on the desired resize border or edge/corner handle.

C Drag the border or handle to the desired location.

The “rubber-band” lines indicate the new window size.

C  Release the mouse button to resize the window.

Minimizing

Use the Minimize button to quickly iconify a window. The Minimize button is the small square on the top
right-hand side of the screen. To minimize a window:

C  Move the pointer to the Minimize button and click.

The window is removed and an icon representing it is displayed instead.

To return the window to its original size:

C Move the pointer to the icon representing the window and double-click.

          The window displays in its normal size.

Maximizing

Use the Maximize button to quickly expand a window to fill the screen. The Maximize button is the large
square on the top right-hand side of the screen. To maximize a window:

C Move the pointer to the Maximize button and click.

The window expands to fill the entire terminal screen.

To return the window to its original size:

C Move the pointer to the Maximize button and click.

The window redisplays in its normal size.
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______________________________________________________________________________________
Data Entry Procedures
______________________________________________________________________________________

Data entry refers to the process of adding, modifying, and deleting information within CAT. There are four
types of data entry procedures:

C ADD — adds new records or subrecords to the database.

C FIND — locates an existing record or subrecord for display or modification.

C UPDATE — modifies an existing record or subrecord.

C DELETE — removes an existing subrecord or record.

The data entry window has two basic formats: Screenform and Spreadsheet. Screenform data entry presents
a page of field values for one record at a time. Spreadsheet presents the fields and records in a
column-and-row format, displaying many records at one time.

______________________________________________________________________________________
User Interface

You use the mouse pointer and keyboard to perform the data entry procedures. The pointer moves the
cursor from field to field and interacts with the data entry window through three basic user interfaces: push
buttons, the menubar, and the scrollbars. You can also use special keys on the keyboard to perform these
data entry procedures.

Push Buttons

The push buttons are located at the bottom of the data entry window. To activate a push button, place the
pointer over the desired button and click. Depending on the status of the window, some push buttons may
be ghosted and unavailable for use.
The push buttons for Screenform data entry are described below.

C Exit — Exit data entry.

C Clear — Clear data from the window.

C Add — Add the record or subrecord currently displayed.

C Update — Update the record or subrecord currently displayed.

C Delete — Delete the record or subrecord currently displayed.

C Subrec/Rec — Access the first subrecord if pressed when a record is displayed. Access the
parent record if a subrecord is currently displayed.
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The push buttons for Spreadsheet data entry are described below.

C Exit — Exit data entry.

C New — Create record. A blank record is displayed at the bottom of the Spreadsheet; enter
data into fields and move the cursor off record line with arrow keys.

C Copy — Copy the current record. To save the new record, make a change to it and move
cursor off the record line with the arrow keys.

C Delete — Delete the record or subrecord currently displayed.

C Subrec/Rec — Access the first subrecord if pressed when a record is displayed. Access the
parent record if a subrecord is currently displayed.

Scrollbars
The scrollbars enable you to move through the records and fields in the database. The following chart
describes how the scrollbars can be used in Screenform data entry.

SCROLL BAR ACTION RESULT

Vertical scrollbar

Click on down arrow

Click on up arrow

Click below slider

Click above slider

Move one screen down

Move one screen up

Move one screen down

Move one screen up

Horizontal scrollbar

Click on right arrow

Click on left arrow

Click to right of slider

Click to left of slider

Increase one record number

Decrease one record number

Increase one record number

Decrease one record number
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The Spreadsheet data entry screen is laid out in rows and columns so the scrollbars manipulate the screen
differently.

SCROLLBAR ACTION RESULT

Vertical scrollbar

Click on down arrow

Click on up arrow

Click below slider

Click above slider

Increase one record number

Decrease one record number

Move down one screen

Move up one screen

Horizontal scrollbar

Click on right arrow

Click on left arrow

Click to right of slider

Click to left of slider

Move one field right

Move one field left

Move one field right

Move one field left

Menubar Options

The menubar provides options to manipulate the data entry screen. The menubar is the same in both
Screenform and Spreadsheet data entry. The options on the pull-down menus are described in the chart
below. The mnemonic keys are underlined.

MENU OPTION  ACTION

File menu

Print Screen

Field Type

Exit

Print the contents of the screen

Display the field name

Exit data entry

Edit menu
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Edit Field

Erase from BOL

Erase to EOL

Restore Field

Restore Record

Access text editor

Erase field from beginning of line to cursor

Erase field from cursor to end of line

Restore field to original value

Restore all fields in record to original values
(does not restore a deleted record)

Goto menu

First Record

Last Record

Goto RN

First Field

Last Field

First Character

Last Character

Move cursor to first record

Move cursor to last record

Access Find Record by Record Number box

Move cursor to first field in record

Move cursor to last field in record

Move cursor to first character in field

Move cursor to last character in field

Find menu

Enter Find Mode

Start Search

Exit Find Mode

Access Find Screen

Search on values in Find

Exit Find Screen

Help menu

About Data Entry

About X

About Motif

Information on using data entry

Information on using X

Information on using Motif
The data entry menus incorporate mnemonic keys in the menu titles and menu options. The mnemonic keys
for the menubar use the < Alt >key in conjunction with a character key. To select a menu title from the
menubar, hold down the < Alt >key while pressing the character key identifying the menu you wish to
select. To use the mnemonic keys for the menu options, press the character assigned as the mnemonic when
the menu is displayed on the screen.
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Keyboard

You can use special keys on the keyboard to perform the data entry procedures. The special keys include the
cursor control keys, and other labeled keys such as the Escape and Tab keys and combinations of the
Control and character keys.

The Control key is usually labeled on the keyboard as “Ctrl”. When using a Control key and character key
combination, hold down the Control key while pressing the character key identifying the operation you wish
to perform.

The cursor control keys are labeled on the keyboard with arrow symbols. You can use these keys to move
the cursor around the screen. The cursor is the blinking or highlighted bar that indicates the screen position
where data entry can take place. The field that the cursor highlights at a given moment is the current field;
in Spreadsheet data entry, the line containing the current field is the current record.

The following Control key combinations are used to perform data entry procedures and move the cursor
around the screen.

KEYS  ACTIONS

Ctrl-A

Ctrl-B

Ctrl-E

Ctrl-K

Ctrl-L

Ctrl-N

Ctrl-O

Ctrl-R

Ctrl-U

Ctrl-V

Ctrl-X

Ctrl-Z

Display a data entry HELP screen.

Move cursor to first character in field.

Move cursor to last character in field.

Delete all characters from cursor to end of field.

Redisplay (refresh) data entry screen.

Display next page.

Toggle between overstrike (typeover) and insert. Default is overstrike.

 Restore last field deleted.

 Display previous page.

 Move cursor to last field of last page.

 Delete character at cursor. 

Redisplay last status or error message.

You can also use the following special keys<$Ikeys;special> to move the cursor around the screen.
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KEY  RESULTING ACTION

Backspace

Enter

Tab

left arrow

right arrow

up arrow

down arrow

Delete character to left of cursor.

Move cursor to next field. If cursor is at last field,, move cursor to first field of
first page.

Move cursor to previous field.

Move cursor to left within field. If at first character in field,, move cursor to
previous field.

Move cursor right within field. If at last character in field,, move cursor to next
field.

Move cursor up.

Move cursor down.
On a Spreadsheet screen, where information is displayed in a single-line format, you can use the < up
arrow >and< down arrow >keys to add or update information. When you use these arrow keys to move the
cursor off the current line, the information on that line is added or updated.

______________________________________________________________________________________
Adding Records and Subrecords

When you access a data entry screen for the first time, the cursor is located at the first character position of
the first field in which you can enter information. You can enter data only in the fields you can access with
the cursor.

Some data entry screens require that you enter information in certain fields called mandatory fields. If you
fail to make an entry in a mandatory field, CSS displays an error message. In most cases, CSS does not let
you proceed until you have entered the required information.

Some data entry screens contain fields that display information that you cannot modify. These fields are
called read-only fields. Read-only fields are used to identify the record, to repeat information displayed on
previous data entry screens, or to show the results of calculations made from other fields.
To enter data in a field:

C Enter the information identified by the field label.

Press < Enter >to move the cursor to the next field where data can be entered.

C When you have completed data entry on a screen, move the pointer to the Add push button
and click to add the record to the database.

C If there is a subrecord linked to the screen, move the pointer to the Subrec push button and
click to access the subrecord screen.
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Many fields have a built-in error-checking function which requires that you enter valid information for a
particular field. For example, a field for entering a numeric data will not accept alphabetic characters. If you
enter incorrect information, CSS displays an error message; you must enter valid data to continue.
______________________________________________________________________________________
Finding Records and Subrecords

The scrollbars, the Find menu, and several options on the Goto pull-down enable you to locate records in
the database for viewing, modification, or deletion. You can move forward and backward through the entire
recordset, or you can use the FIND capability to specify only records matching the criteria you enter. CSS
assigns a number to each record when it is created; if you know the number of a particular record, you can
display the record by entering its number.

C In Screenform data entry, to move forward through the records or subrecords in the database,
click on the right arrow or to the right of the slider in the horizontal scrollbar.

C  In Spreadsheet data entry, to move forward through the records or subrecords in the
database, click on the down arrow or to the left of the slider in the vertical scrollbar.

C In Screenform data entry, to move backward through the records or subrecords in the
database, click on the left arrow or to the left of the slider in the horizontal scrollbar.

C In Spreadsheet data entry, to move backward through the records or subrecords in the
database, click on the down arrow or below the slider in the vertical scrollbar.

The FIND Capability

To use the FIND capability to display records or subrecords matching criteria you specify:

C Click on the Find menu title and then click on the Enter Find Mode option.

The Find screen is displayed. It is similar to the data entry screen except that all push buttons
but Clear are ghosted.

C Enter the field value(s) which you want to match and click on the Start Search option.

If CSS finds a match, a message is displayed reporting the number of records found matching the
value(s) specified. The first record matching the value(s) is displayed.  If applicable, click on the
scrollbar to display additional records matching the value(s) specified.

C If you are in the Find screen and you decide that you do not wish to conduct a search, click
on the Exit Find Mode option.

C To locate items by record number click on the Goto menu title and then click on the
Goto RN . . . option. A dialog box is displayed. Move the pointer to the Find Record
Number space and click. Type the desired record number in the space and press < Enter >.
The record corresponding to the record number is displayed.

C To move to the first or last record or subrecord in the database, click on the Goto menubar
option and then click on the First Record or Last Record option on the pull-down menu.
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Wildcard Characters

When using the FIND capability to search for matching field values, you can use the question mark (?) and
asterisk (*) as wildcard characters<$Iwildcard characters> for finding data.

C The question mark matches any single character. Multiple question marks match a specific
number of characters. For example, A?C matches all values of three characters beginning
with A and ending with C; A?? matches all values of three characters beginning with A.

C The asterisk  matches any number of characters (0 or more). For example, A* matches all
values beginning with A, regardless of length.

You can use the wildcard characters together; for example, ?BC* matches all values that have BC as the
second and third characters. Note that when an asterisk is used, it must be the last character.
______________________________________________________________________________________
Updating Records and Subrecords

You can edit or update information by typing over displayed data. To update a record:

C Locate the record requiring modification by using one of the methods described above.

CSS displays the records requested.

C Use the special keys and/or the Goto pull-down menu options to position the cursor on the
field requiring the change.

To insert characters at the cursor position without overwriting existing characters, use 
< Ctrl-O >to toggle between insert and overstrike. Overstrike is the default.

C Type the correct information. You can only update those fields that can be accessed with the
cursor.

C Click the pointer on the Update push button to store the new information in the database.
______________________________________________________________________________________
Deleting Records and Subrecords

In addition to adding and modifying records, CSS enables you to delete records and subrecords. If you
delete a record, all of its associated subrecords are also deleted. If you delete a subrecord, only that
subrecord is deleted. Be aware the once you delete a record, it is gone from the database; you cannot restore
it. To delete a record:

C Locate the record to be deleted by using one of the methods described above.
CSS displays the records requested.

C Click on the Delete push button to initiate the deletion process. A dialog box is displayed for
you to confirm the action before the record is actually deleted from the database.
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______________________________________________________________________________________
Producing Reports and Graphs

CSS enables you to produce detailed reports and graphs on the information you have entered in the
application database. You can request reports and graphs through a menu that lists them, and display them
in a View File window or send them to the printer or plotter.
When in View File you can:

C View the entire contents of the file.

C Continue processing in CSS and return to the CSS window.

C Look at another file.

C Locate strings within a text file.

C Print the file.

______________________________________________________________________________________
Using the View File Window

The View File window is a separate window which is manipulated by scrollbars, push buttons, and a
menubar. You can resize and move the View File window. If you resize a text file, the amount of text that is
visible changes, but the size of the text does not. If you resize a graphics file, the size of the graph and any
text fonts changes, but only one page of a graph is visible in the window at a time.

Push Buttons

The push buttons are located at the bottom of the View File window. To activate a push button, place the
pointer over the desired button and click. The push buttons and their functions are described below.

C Exit — Exit View File.

C Continue — Continue processing in CAT Compass; keep View File window open.

C Select — Display a new file in the View File window; activate the File Selection box.

C Another — Create another View File window; activate the File Selection box.

C Find — Access Find text requestor to locate string in text file.

C Repeat — Repeat search on last Find string. (This option is ghosted until Find is used in the
current View File window.)

C Print — Print a text file; plot a graphics file.
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Scrollbars

Because most files are too large to fit in one window, the scrollbars on the bottom and right side enable you
to move about the file to display different sections in the window. Scrollbars also indicate the portion of the
file that is shown in the View File window.

Because of the differences between text and graphics files, the scrollbar manipulates them differently.
Movement in a text file is based on lines and columns. In a graphics file it is based on pages and you move
one complete page at a time.

The size of the vertical slider indicates the number of pages of a graphics file. The smaller the slider the
greater the number of pages. Except for network plots, in a graphics file the horizontal slider fills the
scrollbox indicating that a complete page is being shown at one time.

The following charts describe how to use the scrollbar to move in either a text or graphics file.

Text File

TO MOVE DO THIS:

1/2 page left

1/2 page right

1 page left

1 page right

Click on the left arrow

Click on the right arrow

Click to the left of the slider

Click to the right of the slider

1 line up

1 line down

1 page up

1 page down

Click on the up arrow

Click on the down arrow

Click above the slider

Click below the slider

Graphics File

TO MOVE:  DO THIS:

1 page up

1 page down

1 page left

1 page right

Click on the up arrow or above the slider

Click on the down arrow or below the slider

Click on the left arrow or to the left of the slider

Click on the right arrow or to the right of the slider
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Menus

The menubar provides options to manipulate the View File window. To use these menus, move the pointer
to the menubar and click the mouse button. The menu is displayed. As you move the pointer up and down
the menu, each option is highlighted as you pass the pointer over it. To select an option, place the pointer
on it and click.

The View File menus are described below. The mnemonic key for each menu or option name is underlined.

MENU OPTION  PURPOSE

File menu

Print

Exit

Print or plot complete file

Exits View File

Goto menu

Top

Bottom

Left

Right

Moves to top of file

Moves to end of file

Moves to left side of file

Moves to right side of file

Help menu

About View File

About CAT

About Windows

Information on using View File

Information on using CAT

 Information on using Windows

______________________________________________________________________________________
Viewing the File

You can view the entire file using the scrollbars and/or the Goto menu.

The vertical scrollbar moves up and down through the file. The horizontal scrollbar moves left and right
across the file. You manipulate the scrollbars by placing the pointer on the scrollbar arrow or box and
clicking.

Use the Goto menu to move to the top, bottom, left, or right side of the file. To access the Goto menu, click
the pointer on the Goto menu title in the menubar. To move within the file, click on the desired option in
the Goto menu.
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______________________________________________________________________________________
Continuing Processing in CSS

When you open a View File window, processing is suspended in CSS. You can continue the processing by
clicking on the Continue push button. Use this feature to view a graph, return to CSS, change some data,
generate the graph again, and re-execute View File so that you can compare the two graphs.

After you use the Continue option once in a View File session, it is unavailable for further use and the
Continue push button is ghosted. However, if you open another View File window, you will be able to
execute Continue from it.

To continue processing in CSS:

C Move the pointer to the Continue push button and click.

Processing continues in CSS and the Continue push button is ghosted.

C To return to CSS, move the pointer to that window and click.

C To return to View File, move the pointer to the View File window and click.

______________________________________________________________________________________
Locating a String within a Text File

You use the Find push button to locate a string within a text file. You cannot search for a string in a
graphics file. The search for the string begins at the first line of text visible in the window; when the string
is found, it is highlighted in the file. To repeat the search starting from the location of the last found string,
click on the Repeat push button.

To locate a string:

C Click on the Find push button.

The Find box is displayed.

C Enter the string in the Find box. You cannot specify wildcards in your search string. Press
< Enter > or click on the OK push button to start the search.

If you decide not to continue the search, click on the Cancel push button.

If found, the string is highlighted in the file; otherwise, a message specifying that the string 
was not found is displayed.

C To repeat the search, click on the Repeat push button.
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______________________________________________________________________________________
Viewing Another File

You can view another file by replacing the file in the current file window or by opening a new file window.
To replace the current file, click on the Select push button. To open another window, click on the Another
push button.

Specify the name of new file by selecting it from the File Selection box. The File Selection box contains a
list of directories and files. The directory you accessed View File from will be the current Filter. The files
listed are controlled by the Filter; to change the file list, you must change the Filter.

C To change the Filter, click on one of the directories in the list and then click on the Filter
push button.

You can specify wildcards in the Filter by typing them into the Filter box and then clicking
on the Filter push button.

C To select a file from the File Selection box, double-click on the file name or click on the file
name and then click on the OK push button.

If you accessed the File Selection box with the Select push button, the file is displayed in the
current View File window.

If you accessed the File Selection box with the Another push button, the file is displayed in
a new View File window. Use the pointer to toggle between the open View File windows
and to resize and move the windows so all are visible.

______________________________________________________________________________________
Printing a File

You can print or plot a file from within View File. Text files are printed and graphics files are plotted. The
Print option is available from the Print push button or from the File menu.

To print or plot the current file in View File with the Print push button:

C Move the pointer to the Print push button and click.

The file is sent to the printer if it is a text file, or sent to the plotter if it is a graphics file.

To print or plot the current file in View File from the File menu:

C Move the pointer to the File menu title and click.

The File menu is displayed.

C Click on the Print option.

The message “Printing File” is displayed in a dialog box and the file is output.
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________________________________
3 CSS Menus   ________________________________
This section describes the procedures for logging on and off the CSS, and the menus associated with the
application.

_________________________________________________________________________
Logging On and Off
______________________________________________________________________________________

The instructions presented in this section are generic; your systems administrator may configure your
system so that some steps may not be necessary.

Most log on procedures require that you enter your login ID and your password. To maintain system
security, you should memorize your log on ID and password.  If you forget them, contact your system
administrator.

To log on to CSS

C Double click on the CSS icon

C Enter your ID and password at the prompt requesting them.

The system verifies the information and grants you access to CSS.  If the information
provided is incorrect you will be prompted to reenter them. If you are unable to access CSS,
contact your system administrator.

To exit CSS

C Select the File option from the main menu.

The File pull-down menu is displayed, which includes your exit options.

C Select Main menu option to be returned to the main CSS menu.

If you have access to both CSS and P/PMS this will take you to the main log in screen.

C Select Leave System option  to leave the CSS application.

This will exit the CSS application.
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_________________________________________________________________________
The Main Menu
______________________________________________________________________________________
When you log onto CSS, the CSS main menu bar is displayed across the top of the window.  The menu bar
contains the following options: File, Edit, Process, Options, Setup and Reports.

Each of these options when selected displays a pull-down menu with additional options.  When you make a
selection from a pull-down menu, you are provided with another menu, a dialog box, or a data entry screen.

Each menu option is described below.  More detailed instructions on these menu options are described later
in this manual.
______________________________________________________________________________________
File menu

The File menu contains a series of options which enables you to control the structure of your project. The
file menu is shown below.

The options on the File menu are described below.

C Open- Enables you to select a network specification, resource availability table, or what-if
network

C New- Enables you to create a program environment, network specification, resource
availability table, calendar, federal calendar, or what-if.

C Copy- Enables you to duplicate a network specification, job from library, resource
availability table, or calendar

C Delete- Enables you to delete a network specification, resource availability table, calendar,
or what-if network.

C Change- Enables you to change a network specification, resource availability table, or
calendar.

C Exit- Allows you to exit CSS, go to the P/PMS main menu, or exit to the CAT   prompt.
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________________________________________________________________________
Edit Menu

The edit menu contains option that allow you to enter and modify information about the various network
structures.  You can enter data about the Organizational Breakdown Structure, Work Breakdown Structure,
Resource Specifications, Resource Availabilities, Activities and Resource Requirements, Constraints and
Actuals Accounting. These options are described in section 5, of this manual.

______________________________________________________________________________________
Process Menu

The Process menu contains options for performing time analysis, resource scheduling, resource
summarization, baselining, WBS/OBS schedule roll-ups, actual hours summarization and earned value
analysis. These options are described in section 6 of this manual.
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_____________________________________________________________________________
Options Menu

The options menu has selections for various system utilities, including utilities for importing and exporting
data.  You can also display information about your user environment from this menu. These options are
described in section 9 of this manual.

The system utilities option enables you to display spooler status, display printer status, display plotter
status, display directory listings.

The macro utilities option enables you to edit macros for data entry, gantts, logic diagrams  and reports.
(You must have systems administrator access to use this function).
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___________________________________________________________________
Setup Menu

The set up menu enables the user to perform administrative setup tasks and set system defaults.  This option
on this menu provides for user, recordset, field and format, and macro administration; utilities; an default
settings for data entry and roll-ups.

These options are described in Section 10, “Performing System Administration.” 

The default entry settings option enables you to choose Screenform or Spreadsheet as the default data entry
method under the Edit menu.  You can also choose a pre-selected setting which uses Screenform with some
options and Spreadsheet with others, depending on which is better suited for the data being entered.

The default network settings can be selected for either the current network or extended networks.  The

default roll-up setting can apply to all networks, the current network, or selected networks.



3 - 6

___________________________________________________________________
The Reports Menu (formerly the Views option under the File menu)

When you select the Reports option from the menu bar, the window changes to display the reports menu bar
across the top of your screen.  The menu bar contains the following options: File, Admin, Network,
Program, and resource.  

Each of the options when selected displays a pull-down menu with additional options.  These options
enable you to view or print various reports and graphs of the data in the CSS application.  The reports and
graphs are described in Section 7, “Generating Reports and Graphs.”

The File option displays a pull down menu with selections for returning to the CSS main menubar, exiting
to the CAT prompt, and exiting the operating system.
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_____________________________________________________________________________________
The Help Menu  

Included on the main CSS menu bar is the Help menu.  The help feature will answer many questions you
may have while you are working with the CSS system. The help menu is shown below.

Please contact the CSS system administrator if your unable to find the answer to your questions in the
Help area of CSS.
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___________________________________________
4  Defining the Environment________________________________
Before you can use the CSS application to analyze and schedule activities, you must specify a working
environment. The environment includes definitions for the program network, resource availabilities, and
schedule calendars. It should be noted that a network can be created without defining the Network
Environment.

The environment provides a framework for the network analysis you can perform with CSS by creating a
CAT database structures for data entry and processing. After you define the environment, you can enter
specific data for network activities, resource availabilities and rates, and other associated information using
the Edit option of the main menu.

The File option of the CSS main menu enables you to define each component of the environment. The
options under File are used to select (Open), create (New), Copy, Delete, or Change components such as
network specifications, resource availability tables, and calendars.

The What If selections under several of the options are described in chapter 8, “Using the What If
Capability.”

The New option under file provides the following selections:

C Program Environment — enables you to describe the program and establishes the
relationships for organizational breakdown structures (OBSs), work breakdown structures
(WBSs), and earned value capability, if desired

C Network Specification

C Resource Availability Table

C Calendar — enables you to create, delete, duplicate, modify, and select calendars for
scheduling network activities and resources.
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After the program is baselined, you cannot change the fields for OBS, WBS, and Earned Value information
on the Program Environment screen. You cannot create, delete, or duplicate networks or resource
availability tables, although you can select them and modify their titles and report captions. Additionally,
you cannot change the calendar specifications.

The program is structured this way to assure that, once a baseline has been established, program progress is
monitored against an immutable plan. You can make a change to a copy of your baselined program through
the What If selection. Refer to chapter 8, “Using the What If Capability.”

This chapter describes how to define the components of the working environment for the program.
______________________________________________________________________________________
Network Specification
______________________________________________________________________________________

A network is the logical sequence of tasks for completing a given program and the resources necessary to
accomplish those tasks. A well-constructed network helps you track and control a program to ensure its
successful, timely completion.

The following selections under File are used with network specifications.

C New and Change access screens for you to enter or modify information for defining a
particular network.

C Copy enables you to create a duplicate of an existing network that you can then rename and
modify.

C Delete enables you to remove an existing network definition.

C Open enables you to specify a network for use with other options. The network you specify
becomes the default.

You must create a network with New or Copy before you can use the network with any other menu options.
______________________________________________________________________________________
Creating a Network
______________________________________________________________________________________

Network Creation Capabilities are the heart of the CSS system. Tailored networks for M!DOT
Construction jobs can be created using several different methods

The 4 ways to create a network are as follows:

1. Task by Task
2. Selected Job Type
3. Generation by Job Characteristics
4. Copy Existing Job (Active Jobs, Library Jobs)
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NOTE: ALL NETWORKS ARE SUBJECT TO REFINEMENT AND VERIFICATION OF
ACCURACY BY THE RESPONSIBLE USER AND IN NO WAY IS INTENDED AS THE
COMPLETED NETWORK

When you select Network Specification under New, the Create a Network screen is displayed as shown
below.

To create a network, you must enter a name for the network, the job number and job type. The Job Number
and Network Name must come from an existing MDOT job. You will be prompted to choose a number
from a pop-up list that will appear when you first enter the Create a Network screen. Once you have
selected the job number, the Network Name will automatically be entered. You can also specify a base date,
whether the job is metric or standard, descriptive title, and report caption.

If you choose not to use an existing MDOT job number and name, simply enter the desired job number and
name that you would like to use. 

It should be noted that all networks that are created, should be associated with an existing MDOT job. 

The following is an explanation of each of the fields on the Create a Network screen.

Network Name
Specifies a unique name for the network. An entry is required in this field. This field will hold up to
8 Characters. CSS will convert all alphabetic characters to lowercase.

Job Number
Specifies a unique job number assigned by the user. This filed can hold up to 5 Characters

Job Type
This field is not a mandatory field at this time. The user can select from a list of predefined job types
for MDOT. Currently, two job types are available: Crush and Shape and Overlay.
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Base Date
Specifies the start date of a network schedule. If you do not specify a base date when you create a
network, you can set using the Base Date/As of Date option under Edit.

Network Title
Describes the network. Will hold up to 30 characters.

Report Caption

Specifies text for an optional third title line on reports specific to the network. The report caption
field will hold up to 50 characters

When you have finished entering the information for the new network, click the ADD button on the bottom
of your screen.  You will then be asked if you would like to create a network based on characteristics? Enter
<N> and click on OK. The message "Creating network recordset . . ."  is displayed. The newly created
network becomes the current network. If you would like to create a network based on characteristics, refer
to the section: Creating a Network by Job characteristics below. 

If you decide not to create a network, press < F1 >or click on the Exit button at the bottom of your screen.

To enter specific data about the network, you will use the selections under the Edit option on the main
menu.

______________________________________________________________________________________
Creating a network Task by Task

This function would be used by the user that desires not to utilize any of the existing CSS network
templates. If you choose to use this method for creating a job network, simply answer no when prompted as
to weather or not you would like to use a template or characteristics.

Once network has been established, you may begin to enter task information.  See section 5, Entering and
Modifying Information.

______________________________________________________________________________________
Creating a Network by Selecting a Job Type

Once the user has entered the Job Number and the Job Name, he or she will be prompted to select a job
type.  The user may select the type of job that they will be developing a network for.  After inputting the
remaining information, and clicking on the ADD button, the network for the selected job type will be
generated.
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______________________________________________________________________________________
Creating a Network by Job Characteristics

This option takes user supplied job characteristics that describes the work to be done for a given job and
combines the respective work strings to create the network.  Once the network is created, standard
production rates are automatically applied to user supplied quantities resulting in a network with an
approximate finish date.

To use this function, simply follow the instructions as you were creating a network tasks by task.  Once you
have completed entering all required information and click on the ADD button you will be asked if you
would like to create a network using characteristics.  Enter “Y” and click ok.  

The CSS Network Generator screen will then be displayed asking you to select from a list of different job
characteristics.  Simply input the requirements and click on UPDATE at the bottom of the screen.  Your
network will be generated.

______________________________________________________________________________________
Duplicating a Network
______________________________________________________________________________________

Another way of creating a network is to make a duplicate of an existing network using the Copy option
under File. This is useful if the new network is similar to one you have created previously. You can make
changes to the duplicated network while keeping the original intact. You must have read permission for the
network to duplicate it.

To duplicate a network definition, select Network Specification under Copy. Another pop-down menu is
displayed listing all the networks that have been created. Select the network you wish to duplicate. The
Duplicate a Network screen is displayed as shown below.
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To duplicate a network, you must enter a name for the new network. The new network that is created will
include the same data as the original.

The following is an explanation of the fields on the Duplicate a Network screen.

Existing Network Name

Identifies the name of the network selected for duplication. This is a read-only field.

New Network Name

The user specifies a unique name for the duplicate network. An entry is required in this field.  CSS
converts all alphabetic characters to lowercase if you did not enter them that way.

New Network Title

Describes the duplicate network.

New Report Caption

Specifies text for an additional title line describing the network on reports.

When you have finished entering the information for the duplicate network, press < F6 >or click on ADD at
the bottom of the data entry screen. The new network will be created.

If you decide not to duplicate a network, press < F1 >or click on Exit.

To enter specific data about the new network, use the selections under the Edit option on the main menu.
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______________________________________________________________________________________
Selecting a Network

Use the Open option under File to choose the network that you want to work with. Select Network
Specification, then select the desired network from the pop-down menu. The selected network becomes the
default network used for any data entry or processing until you select a different network.

______________________________________________________________________________________
Using the Network Logic Editor

Once you have created your network, you may use the Network Logic Editor under the Edit menu to make
changes to your network.  Section five, Entering and Modifying Information also explains how to make
changes to your network.  However, this section is included to show you how to use the NLE display screen
to change the information in your network.

After you have established your network, click on the Network Logic Editor from the Edit menu.  This will
bring up the Network Logic Editor Screen.  If you have chosen to build your network task by task, the
screen will be blank.  If you have built your network by using job type of the job characteristics function,
the network information will be displayed.

If you are building your network task by task, you can click and hold the left mouse button on a blank area
of the screen and drag you pointer an few inches and release mouse button.  A blank task box will be
inserted. From here, you may enter task information by double clicking on the task box.  The task
information screen will be displayed behind an active screen.  Click on the window behind the active screen
to see the task information.

After you have brought up the Enter and Modify Activities screen, you may begin to enter information
about the particular task.  This screen is described in detail in section 5 of the Users Manual. 

To input activity constraints within the Network Logic Editor, simply click on the left or right side of the
activity when you mouse turns to cross hairs and drag a line the succeeding activity. This will establish
either a finish to start, start to start, finish to finish or start to finish.  This will depend on were you release
this cross hairs.  Please be aware that constraints can be established by using Constraints under the Edit
Menu.  

Predefined Tasks

NLE will allow the user to select predefined tasks with standard production rates from a list of over 180
construction tasks.  Predefined tasks can be accessed by inserting a “?” in the Activity Type field.  This will
produce a pop-down menu of the construction activity types.  After an activity type is selected and the
cursor is moved to the Description field, a pop-down will appear listing the activities that can be selected
from the given activity type group.  After selection of a given task, a standard production rate and calendar
will be displayed for the activity.

Production rates can be adjusted (given the conditions of a specific job) by inserting a user supplies rate
into the Adjusted rate field.
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______________________________________________________________________________________
Changing a Network Title

Use the Change option under File to change the network title and report caption. You must have write
permission for the network to modify it.

Select Network Specification, then select the desired network from the pop-down menu. The Modify a
Network screen is displayed as shown below.

This screen is similar to the Create a Network screen (described above); it contains the current information
for the selected network.

Press < F7 >or click on Update to save your changes. Press < F1 >or click Exit if you decide not to save the
changes.

Note that you cannot change the network name with this option. To change the network name, you must
duplicate the original network using the desired name, then delete the original network.

______________________________________________________________________________________
Deleting a Network

Use the Delete option under File to permanently remove a network when it is no longer valid. Select
Network Specification, then select the desired network from the pop-down menu. You must have write
permission for the network to delete it. If you delete a network in a multi-user environment, you should
inform the other users.

The following prompt is displayed when you are deleting an existing network:

Are you sure you wish to DELETE network '<<name>>'? (n):

Enter y to delete the network, or press < Enter > to retain it.
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______________________________________________________________________________________
Resource Availability Table Specification
______________________________________________________________________________________

Resource availability tables specify the resources available to one or more networks. Resources include the
people and material necessary to produce the deliverables and complete the program. Resource
availabilities determine when the resources can be used during the program and for how long.

When you create resource availability tables, the CSS application defines fields and recordsets in the
system database to hold the resource availability data. After a table has been created, you can use the
selections under the Edit option to enter specific resource availability data.

If you are using the earned value capability, you must create a resource availability table.

The following selections under File are used with resource availability tables.

C New and Change access screens for you to enter or modify information for defining a
particular resource availability table.

C Copy enables you to create a duplicate of an existing resource availability table that you can
then rename and modify.

C Delete enables you to remove an existing resource availability table definition.

C Open enables you to specify a resource availability table for use with other options. It makes
the resource availability table the current one.

You must create a resource availability table with New or Copy before you can use the table with any other
menu options.
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______________________________________________________________________________________
Creating a Resource Availability Table

When you select Resource Availability Table under New, the Create a Resource Availability Table screen
is displayed as shown below.

To create a resource availability table, you must enter a name for the table. You can also specify a
descriptive title.

The following is an explanation of each of the fields on the Create a Resource Availability Table screen.

Resource Availability Table Name

Specifies a unique identifier for the resource availability table. An entry is required in this field. You
cannot specify a name already used for a network. CSS will convert all alphabetic characters to
lowercase.

Resource Availability Table Title

Describes the resource availability table.

Report Caption

Specifies text for an optional third title line describing the resource availability table on reports.

When you have finished entering information for the new resource availability table, press < F6 >or click
on Add. The newly created resource availability table becomes the current table. If you decide not to create
a resource availability table, press < F1 >or click on Exit.

To enter specific resource availability data, use the selections under the Edit option on the main menu.
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______________________________________________________________________________________
Duplicating a Resource Availability Table

Another way of creating a resource availability table is to make a duplicate of an existing table using the
Copy option under File. This is useful if the new table is similar to one you have created previously. You
can make changes to the duplicated table while keeping the original intact. You must have read permission
for the resource availability table to duplicate it.

To duplicate a resource availability table, select Resource Availability Table under Copy. Another
pop-down menu is displayed listing all the tables that have been created. Select the table you wish to
duplicate. The Duplicate a Resource Availability Table screen is displayed as shown below; it is similar to
the Create a Resource Availability Table screen.
To duplicate a resource availability table, you must enter a name for the new table. You can also specify a
new descriptive title.

The following is an explanation of the fields on the Duplicate a Resource Availability Table screen.

Existing Resource Availability Table Name
Identifies the name of the resource availability table selected for duplication. This is a read-only
field.

New Resource Availability Table Name
Specifies a unique identifier for the duplicate resource availability table. An entry is required in this
field.

New Resource Availability Table Title
Describes the new resource availability table.

New Report Caption
Specifies text for an additional title line describing the resource availability table on reports.
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When you have finished entering the information for the duplicate resource availability table, press
< F6 >or click Add. The new resource availability table is created. If you decide not to duplicate an resource
availability table, press < F1 >or click on Exit.

To enter specific resource availability data, use the selections under the Edit option on the main menu.

______________________________________________________________________________________
Selecting a Resource Availability Table

Use the Open option under File to choose a resource availability table to work with. Select Resource
Availability Table, then select the desired table from the pop-down menu. You can continue with other
menu options as desired. The selected resource availability table becomes the default used for any data
entry or processing until you select a different resource availability table.

_________________________________________________________________________
Modifying a Resource Availability Table

Use the Change option under File to change a resource availability table title and report caption. You must
have write permission for the resource availability table to modify it. Select Resource Availability Table,
then select the desired table from the pop-down menu.  A screen similar to the screen used for creating a
resource availability table (described above) is displayed, containing the current resource availability
information. Change the table title and report caption if desired and press < F7 >, or press < F1 > if you
decide not to change the title or caption.

Note that you cannot change the resource availability table name with this option. To change the table
name, you must duplicate the original table using the desired name, then delete the original table.

______________________________________________________________________________________
Deleting a Resource Availability Table

Use the Delete option to permanently remove a resource availability table when it is no longer valid. You
must have write permission for the resource availability table to delete it. If you delete a resource
availability table in a multi-user environment, you should inform the other users.

Select Resource Availability Table, then select the desired table from the pop-down menu. The following
prompt is displayed:

Are you sure you wish to DELETE resource availability table '<name>'? (n):

Enter y to delete the resource availability table, or press < Enter > to retain it.
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______________________________________________________________________________________
Calendars
______________________________________________________________________________________

The CSS application enables you to define up to 90 calendars for scheduling work. You can use calendars
to establish work periods, rest days, and holidays for the work performed during the course of the program.

You might need several calendars because of differences in resource availabilities, work hours per day,
number of shifts, and rest days. For example, some people work a standard eight-hour day, while others are
scheduled to work one of several shifts in a day or have a shift or workday of more than eight hours. You
can also specify holidays and rest periods during which work is not performed.

If you specify a year or a month as a work period, rest days and holidays are ignored for scheduling.

It is recommended that program resource requirements and availabilities be scheduled on the same
calendar.

If you want to perform earned value analysis, do not use hourly and/or continuous calendars.

The following options under File are used with calendar specifications.

C New — enables you to specify a new calendar definition.

C Copy enables you to create a copy of an existing calendar that you can then modify

C Delete — enables you to delete an existing calendar definition

C Change enables you to change an existing calendar definition.

Whether or not you have administrator access, you can access all Calendar options. These options are
described on the following pages.
______________________________________________________________________________________
Creating a Calendar

You can create additional calendars as you need to cover all scheduling possibilities in your network. When
you create a calendar, all calendar periods are specified as work periods; you must specify any holidays and
rest periods during which work is not performed.

If you want to perform earned value analysis, do not use hourly and/or continuous calendars.

Three screens are used to create a calendar. The first screen establishes the calendar and its basic time unit;
the next two request holiday and rest period information. Any scheduling calculations CSS performs are
based on work periods only. Holidays and rest periods are not included in scheduling calculations.
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To create a calendar, select Calendar under New.  The first Create a Calendar screen is displayed as shown
below.

The following is an explanation of the fields on the first calendar screen.

Calendar Number

Identifies the calendar with a unique number. The default provided consecutively fills in gaps in the
numbering. For example, if you have already created calendars 1 and 3, calendar number 2 is given
as the default.

If you enter the number of a calendar that has already been defined, an error message is displayed.
Press < Enter > to remove the message and try again.

Calendar Description

Provides a brief description of the calendar. For example, you might enter 4-day week, or 3 shifts.

The remaining prompts on this screen enable you to define the basic time unit for the calendar. You
must make entries at these prompts to establish the calendar.

Period

Use the Period field to specify the number to be used in defining the time unit. Then select one of
the choices at the following prompt to specify the type of work period:

Number of (d)ays, (w)eeks, (m)onths, (y)ears, or number (p)er day:
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Enter the letter in parentheses corresponding to the selection you wish to make as follows:

C (d)ays, (w)eeks, (m)onths, (y)ears — Specifies the time unit for the work period. For
example, if you entered 2 in the Period field and w at this prompt, you would be specifying a
work period of two weeks.

C (p)er day — Specifies the work periods in a single day. For example, if you entered 3 in the
Period field and p at this prompt, you would be specifying three work periods per day — that
is, three 8-hour shifts in a day.

After you finish entering this information, press < F6 >. The second Create a Calendar screen is displayed
as shown below.

Use this screen to enter holidays for the calendar you are defining. The top of this screen includes the
calendar information from the previous screen in read-only fields.

For each holiday you wish to specify, enter the date in one of the following formats:

C MM-DD-YY (for example, 12-25-92)

C DD-MMM-YY (for example, 25-DEC-92).

Press < Enter > after you enter each holiday. You can use the up and down arrow keys to move through the
holiday list and make corrections as necessary.
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When you are done entering holidays, press < F1 > and a prompt is displayed. Enter y at the prompt to
continue with the third Create a Calendar screen, as shown below.

Use this screen to enter rest days for the calendar you are defining. The top of this screen includes the
calendar information from the first Create a Calendar screen in read-only fields.

Rest days are regular days during the week when work is not performed. You should first enter standard rest
days (such as Saturday and Sunday) for the calendar. If the rest days change periodically, you can enter a
break date to identify when the rest days change, and then enter new rest days.

The fields on this screen are described below, followed by procedures for entering information on this
screen.

Rest period break date

Indicates the date when the current rest periods change. For example, your calendar might require
Saturday and Sunday as rest periods for this year and Friday and Saturday as rest periods for next
year.

Rest Day

For each rest day you want to specify, enter the three-letter abbreviation for the day of the week
(SAT, SUN, etc.).

If the From Period and To Period fields are displayed, press < Enter > to use them as described
below. Otherwise, press the < down arrow > key to enter additional rest days.
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From Period/To Period

If your calendar has more than one period per day, use these fields to indicate which period(s) in the
specified day you want to designate as rest periods. Press < Enter > to move between these fields;
press the < down arrow > key to enter another rest day.

When you are entering rest day information:

C If you want to specify standard rest days for the calendar, leave the Rest period break date
field blank and press < F6 >. The cursor moves to the Rest Day field.

C Enter rest days (and from/to periods) as necessary. When you have finished, press < F9 >.
The cursor returns to the Rest period break date field.

C If the specified rest days are to change after a particular date, enter the date in the Rest
period break date field.

Press < F6 >. The cursor moves again to the first Rest Day field, which is now blank. Enter
the new rest days (if necessary) in the Rest Day fields.

C Continue as necessary, entering new break dates and the rest days (and from/to periods, if
applicable) following those dates. You can enter as many break dates as you need.

When you have completed entering rest period information, press < F1 >or ADD at the
bottom of the screen and then press y in response to the prompt to generate the calendar.

______________________________________________________________________________________
Duplicating a Calendar

Another way of creating a calendar is to make a duplicate of an existing calendar using the Copy option
under File. This is useful if the new calendar is similar to one you have created previously. You can make
changes to the duplicated calendar while keeping the original intact.

You might choose to duplicate a calendar when the new calendar has the same holidays as an existing
calendar but specifies a different work period, or if the new calendar uses the same work period but does
not include certain holidays.

To duplicate a calendar definition, select Calendar under Copy. Another pop-down menu is displayed
listing the calendars that have been created. Select the calendar you want to duplicate. The following
prompt is displayed:

DUPLICATING CALENDAR <number (description)>Enter new calendar number or q to quit (2):

You can enter any number between 1 and 90. The sequential number following the highest calendar number
already in use is displayed in parentheses as the default. If you choose to accept the default, press < Enter >.
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If you enter a number for which a calendar has already been created, an error message is displayed. Press
any key to try again.

Enter q if you decide not to duplicate the calendar.

After the duplicate calendar is created, the following prompt is displayed:

Do you wish to MODIFY the new calendar? (y):

If you press < Enter >, the first Modify a Calendar screen is displayed; you can modify the new calendar as
described below. If you decide not to modify the calendar, enter n at the prompt.

______________________________________________________________________________________
Modifying a Calendar

Use the Change option under File to make changes to calendars previously created or duplicated to account
for changes in holidays and rest days.

To modify a calendar, select Calendar under Change. Another pop-down menu listing the available
calendars is displayed. Select the calendar you wish to modify.

The three screens used to modify a calendar are essentially the same as those for creating a calendar. The
first screen establishes the calendar, the second screen requests holiday information, and the third screen is
for entry of rest periods and break dates.

Refer to the information on creating a calendar above for details about the fields on these screens. However,
note that the Function keys used to modify a calendar differ from those used to create a calendar. The
procedure for modifying a calendar is described below.

After you select a calendar to modify, the first Modify a Calendar screen is displayed. You can change the
calendar description or period and time unit on this screen.

Note that you cannot change the calendar number with this option. To change the calendar number, you
must duplicate the original calendar using the desired number, then delete the original calendar.

After you finish modifying this information, press < F7 >. The second Modify a Calendar screen requesting
holiday information is displayed.

When you modify an existing holiday date, use the < up arrow > or < down arrow > keys to move the cursor
off the field and accept the change. To delete a holiday, highlight the holiday date and press < F8 >.

When you have completed modifying holiday information, press < F1>; a prompt is displayed. Enter y to
continue.

After you modify the holiday data, the third Modify a Calendar screen for entering rest day and break date
information is displayed as shown on the next page.
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This screen differs somewhat from the screen used to originally enter this information. Additional Function
keys can be used as described below.

C Use < F2 > and < F3 > to display the break dates and corresponding rest days you have
entered.

C To modify the displayed break date, make the necessary change in the field and press <F7>.

C To modify rest day information for the displayed break date, press < F9 >. Make changes to
the fields as necessary and press < F9 > again. The cursor returns to the Rest Period Break
Date field.

C To add a break date, enter the new break date in the field and press < F6 >. The new break
date is added; you can specify rest days for the break date as described previously.

When you have completed modifying rest period information, press < F1 >; a prompt is displayed. Enter y
to generate the calendar.
______________________________________________________________________________________
Deleting Calendars

Use the Delete option under File to permanently remove a calendar that is no longer valid.

If you delete a calendar from a program, it will also be deleted from the resource availabilities and network
activities for which it was specified. CAT calendar 0, a continuous calendar, is the default.

When you select Calendar under Delete, a pop-down menu listing the available calendars is displayed. Use
the arrow keys to highlight the calendar you wish to delete and press < Enter >. The following prompt is
displayed:

Are you sure you wish to DELETE calendar '<number>'? (n):
Enter y to delete the calendar, or press < Enter > to retain it.
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______________________________________________________________________________________
Program Environment
______________________________________________________________________________________

A program includes at least one activity network, which represents a sequence of tasks. Each program,
whether it be an aircraft manufacturing effort or a software development effort, may be detailed by a WBS
and is scheduled using activity networks.

Any program you create can include an OBS to specify the hierarchy of the work group performing the
network tasks and a WBS to specify the hierarchy of deliverables. By using an OBS and a WBS, you can
track tasks and assign management and technical responsibilities for all parts of a program. Appendix A
contains more information on WBSs.

The program can also include an earned value capability, which shows the completion of work and its
corresponding remuneration.

When you use the options under File to describe programs and their associated structures, the CSS
application defines fields and recordsets in the system database to hold the data. After a program has been
created, you can use the options under Edit to enter specific data about the network structures, resources,
and activities.

When you select Program Environment under New, the Program Environment screen is displayed as
shown below.

You can enter data in the program name, description, and manager fields and the report title and subtitle
fields at any time.

The following is an explanation of each of the fields on the Program Environment screen.
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Program Name

Specifies a unique name for the program.

Program Description

Provides a brief description of the program.

Program Manager

Identifies the person responsible for the program.

Report Title

Specifies the first line of the title for reports pertaining to the program.

Report Subtitle

Specifies the second line of the title for reports pertaining to the program.

______________________________________________________________________________________
OBS and WBS

The next three fields enable you to define an OBS and a WBS. You do not need to specify an OBS or a
WBS to build a network. However, if you choose to use these structures, you must make entries in the
appropriate fields.

If you choose not to use one or more of these structures, press< Esc >to bypass the pop-down menu(s).

OBS Relationship

Specifies the relationship among OBS elements.

A pop-down menu enables you to select one of these options as the field value:

C Standard (no trailing period) — specifies the standard hierarchical coding structure for
OBS elements in a display format with no trailing period, for example, 1.1.1

C Standard (trailing period) — specifies the standard hierarchical coding structure for OBS
elements in a display format with a trailing period, for example, 1.1.1.

C Parent — specifies a coding structure that you create.
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WBS Relationship

Specifies the relationship among WBS elements.

A pop-down menu enables you to select one of these options as the field value:

C Standard (no trailing period) — specifies the standard hierarchical coding structure for
WBS elements in a display format with no trailing period, for example, 1.1.1

C Standard (trailing period) — specifies the standard hierarchical coding structure for WBS
elements in a display format with a trailing period, for example, 1.1.1.

C Parent — specifies a coding structure that you create.

With standard OBS and WBS relationships, you can change the display format from no trailing period to a
trailing period. The reverse is also true. If you change OBS or WBS relationships from one standard display
format to another, the change is automatically made in the corresponding program(s).

If you want to change the OBS or WBS relationship, you need to access the appropriate pop-down menu
from the OBS or WBS Relationship field. Press any key at the appropriate field and then press < Enter >.
The pop-down menu is displayed, enabling you to make your selection.

You can use the parent code only when you create a program. Once OBS or WBS data has been entered,
you cannot change the relationship.

WBS Template

At this time there are no WBS templates available to use while developing your networks.  The user must
use the User Supplied option, and enter the data for the WBS at this time.  
Updates will be supplied to the users as WBS templates are developed.
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______________________________________________________________________________________
Earned Value

The last three fields on the Program Environment screen may be used to establish an earned value
capability for the program. If the program does not require this capability, you do not need to make
entries in these fields.

Earned value is a measure of work performed in terms of budgeted cost. CSS uses the default methodology
displayed to calculate earned value for all activities unless you specify a different methodology for an
activity. For more information, refer to “Activities and Resource Requirements” in chapter 5, “Entering and
Modifying Information.”

To establish an earned value capability, you must specify a WBS. The following three fields are mandatory.

Analysis Start Date

Specifies the date on which earned value analysis is to begin.

Reporting Period

Specifies the time span allotted for the program's standard reporting period.

A pop-down menu enables you to select one of these options as the field value:

C Weekly

C Biweekly

C Monthly.

If you want to change the reporting period, you need to access the pop-down menu from the
Reporting Period field. Press any key and then press < Enter >.  The pop-down menu is displayed,
enabling you to make your selection.

Default Methodology

Specifies the method used for all activities on the Enter or Modify screen for calculating earned
amounts. A pop-down menu enables you to select one of these options as the field value:

C 0/100 — assigns 0 percent credit to the task when it starts and 100 percent credit when it
finishes. When you enter an actual finish date, 100 percent of the planned amount is
considered earned.

Use the 0/100 method for a task that can be completed within one reporting 
period; CSS reports zero earned value each period until the task finishes.

C 100/0 — assigns 100 percent credit to the task when it starts and 0 percent credit when it
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finishes. When you enter an actual start date, 100 percent of the planned amount is
considered earned.

Use the 100/0 method for a small task that can be completed within one reporting
period. For example, for a small R&D program for which the contractor wants to
avoid any risk, the 100/0 method would be appropriate.

C 50/50 — assigns 50 percent credit to the task when it starts and 50 percent credit when it
finishes. When you enter an actual start date, 50 percent of the planned amount is considered
earned; when you enter an actual finish date, 100 percent of the planned amount is
considered earned.

Use the 50/50 method for a task that can be completed within two reporting periods.
The task is assumed to be 50 percent complete in the reporting period it began; the
second 50 percent is completed when the task finishes.

C % Complete — assigns the percentage representing the actual amount of work completed for
the task at the end of the reporting period. For example, if a task is 20 percent complete at
the end of the reporting period, it receives 20 percent credit.

Use the percent complete method for tasks you can define and whose progress can
easily be determined. A task involving many unknowns is difficult to evaluate
objectively by percentage.

After you finish making entries in the Program Environment screen, press < F7 >or update at the bottom of
the screen.

If you want to change the default methodology, you need to access the pop-down menu from the Default
Methodology field. Press any key and then press < Enter >. The pop-down menu is displayed, enabling you
to make your selection.

If you have specified or changed one of the seven summary WBSs for the first time, a message is displayed
confirming that the summary WBS template is loaded. Press any key to continue.
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___________________________________________
5 Entering and Modifying Information___________________________________________
When you have defined a working environment in the CSS application (as described in the previous
chapter), you can then enter and store data within the environment database structures. The data you enter
enables you to build, monitor, and update a program network.

After you enter the network data, you can use succeeding main menu options to schedule and analyze the
network, generate reports and graphs, and perform What If analyses.

The Edit option on the CSS main menu provides a pop-down menu of options which enable you to store
specific information about the program. These options are listed below and described in the following
pages.

C Activities and Resource Requirements

C Constraints

C Base Date/As of Date

C Actuals Accounting

C Organizational Breakdown Structure (OBS)

C Work Breakdown Structure (WBS)

C Resource Specifications

C Resource Availabilities
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All options on this menu access data entry screens for entering the information specified by the option.

After the program is baselined, you cannot change some of the information on the OBS, WBS, and
activities screens, and you cannot access the screens for resource specifications, availabilities, and
requirements and constraints. You can change the As Of Date but not the Base Date. You can enter actuals
accounting information after baselining, however.

This chapter describes the data entry screens for these options.

______________________________________________________________________________________
Activities and Resource Requirements
______________________________________________________________________________________

This option enables you to enter specific information about the network activities and the resources that the
activities require.

Activity information includes a unique code to identify the activity, a description of the work involved, and
activity duration. Resource requirements are stored as subrecords for each activity. The information to
specify a resource requirement includes a code specifying a defined resource, the quantity required, and the
duration for which it is needed.

When you select the Activities and Resource Requirements option under Edit, you can enter activity
information on the two Enter or Modify Activities screens. When you have finished entering information
for each activity, you can enter information for its resource requirements on the Enter or Modify Resource
Requirements screens.

After the program is baselined, however, you can only enter information in the following fields:

C actual start, finish, and status dates

C percent complete

C remaining and expected durations

C earned value method.

You cannot access the Enter or Modify Resource Requirements screen once the program is baselined.

The screens for entering or modifying activities and resource requirements are described on the following
pages.
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______________________________________________________________________________________
Activities

After you select the Activities and Resource Requirements option, the first of two Enter or Modify
Activities screens is displayed as shown below.

The Enter or Modify Activities screens contain the fields used to establish an activity. The following is an
explanation of the fields on this screen.

Activity Code

Identifies the activity with a code of up to 16 characters. An entry is required in this field. It is useful
to make these codes sequential from activity to activity. Two characteristics of activity codes must
be considered when you assign these designations.

First, when the codes are ordered (for production of reports and graphs) they are sorted according to
their ASCII designation. This means that activities numbered 10, 20, 30, and 100 would be sorted as
10, 100, 20, and 30. If you wish the sorting to come out in the order 10, 20, 30, and 100, you must
number the activities 010, 020, 030, and 100.

Description
Specifies the work to be performed.

Duration
Specifies the duration of an activity in calendar work periods (that is, how many work periods it will
take to complete the activity).
If you do not enter a value for this field, CSS assigns a default Duration value of zero.
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Total Float

This is the amount of time that an activity can be delayed from it’s early start date without  
delaying the project finish date of the network.

Calendar #

Specifies the calendar CSS will use to calculate the dates for the activity based on the duration you
entered. If you do not specify a calendar, CSS uses Calendar 0, the continuous calendar. Refer to
chapter 4, “Defining the Environment,” for information on calendars.

If you want to perform earned value analysis, do not use hourly and/or continuous calendars.

Network Base Date

Identifies the start date for the network. This field is read-only and displayed in Screenform only.
The value is established when the network is defined, or in the Base Date/As of Date option
described later in this chapter.

Network As of Date

Identifies the current progress date for the network. This field is read-only and displayed in
Screenform only. The value is established in the Base Date/As of Date option described later in
this chapter.

Early Start Date

Specifies the earliest date on which the activity can begin as calculated by the Analysis function
of CSS.

Early Finish Date

Specifies the earliest date on which the activity is expected to end. The activity may finish 
earlier but cannot finish later than the planned finish date without causing a delay in other 
activities in the network.

Late Start Date 

Specifies the latest that a task can start without effecting the start of any succeeding tasks.

Late Finish Date

Specifies the latest that a task can be completed wihout effecting the start of the succeeding 
task. 
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Forced Date

Specifies the date on which the activity must begin. Data in this field is overridden by the 
value in the Day of Week field when applicable.

Day of Week

Specifies the day on which the activity should begin. Use the standard three-letter 
abbreviations for day names — MON, TUE, etc. This field overrides a conflicting value in the
Forced Date field.

Actual Start Date

Specifies the date on which the activity began.

If you want to specify an activity as a milestone, which has a zero duration, the Actual Start Date
should match the Actual Finish Date except that the Actual Finish Date specifies a time as well as
a date. You do not need to enter a time in the Actual Start Date field.

Actual Finish Date

Specifies the date on which the activity ended.

If you want to specify an activity as a milestone, which has a zero duration, enter the Actual Finish
Date as DD-MMM-YY:0001. It should match the Actual Start Date except that the Actual Finish
Date specifies a time as well as a date.

Status Date

Identifies when an in-progress activity was last updated. CSS sets the status date to the as of date
when an actual start date is entered.

After you have completed entries on this screen, press < Enter > or < Ctrl-N >. The second Enter or Modify
Activities screen is displayed as shown below. Only user codes are available.
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The two fields at the top of this screen — Activity Code and Description — are read-only fields. They
display information entered on the first Enter or Modify Activities screen.

The following is an explanation of the fields on this screen.

Earned Value Methodology

Specifies the means of reporting work performance and calculating the planned cost. If you do not
specify a methodology in this field, CSS defaults to the methodology you specified when you defined the
program environment.

A pop-down menu enables you to select one of these options as the field value:

C 0/100 — assigns 0 percent credit to the task when it starts and 100 percent credit when it
finishes. When you enter an actual finish date, 100 percent of the planned amount is
considered earned.

Use the 0/100 method for a task that can be completed within one reporting period, 
because CSS reports zero planned cost each period until the task finishes.

C 100/0 — assigns 100 percent credit to the task when it starts and 0 percent credit when it
finishes. When you enter an actual start date, 100 percent of the planned amount is
considered earned.

Use the 100/0 method for a small task that can be completed within one reporting period.
For example, for a small R&D program for which the contractor wants to avoid any risk, the
100/0 method would be appropriate.

C 50/50 — assigns 50 percent credit to the task when it starts and 50 percent credit when it
finishes. When you enter an actual start date, 50 percent of the planned amount is considered
earned; when you enter an actual finish date, 100 percent of the planned amount is
considered earned.

Use the 50/50 method for a task that can be completed within two reporting periods. The
task is assumed to be 50 percent complete in the period it began; the second 50 percent is
completed when the task finishes.

Use the percent complete method for tasks you can define and whose progress you can
project. A task involving many unknowns is difficult to evaluate objectively as a percentage.



5-7

The table below summarizes this information.

                   FUND ALLOCATIONS

METHOD AT
START

AT FINISH TYPE OF TASK

0/100

100/0

50/50

% Complete

0

100

50

0

100

0

50

Corresponding
percentage

Can be completed in one reporting period

 Can be completed in one reporting period

Can be completed in two reporting periods

Well-defined task with predictable progress

WBS Code

Identifies the WBS element associated with this activity. If you are using the earned value 
capability, you must specify a WBS code for each activity.

If you enter an invalid code based on current WBS data, this prompt is displayed:

ERROR: Invalid WBS code. Press any key to re-enter.

Press any key. The cursor returns to the WBS Code field where you can make your 
correction.

WBS Description

Provides details on the hardware, software, services, or data associated with the WBS element. This
is a read-only field.

OBS Code

Identifies the OBS element associated with this activity. This is a read-only field.

OBS Description

Describes the organizational group associated with the OBS element. This is a read-only field.

User Fields 1, 2, 3, 4

Allow input of additional descriptive information.
Press < F9 > to access the Enter or Modify Resource Requirements screen.

When you finish modifying an activity, press < F7 >or click on Udate  to update the record; then
press < F9 >or Subrec to access the Enter or Modify Resource Requirements screen.
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______________________________________________________________________________________
Resource Requirements

Resource requirement information specifies what and how many resources are required to complete the
activity. You can enter as many resource requirements as you need for an activity.

If you are using the earned value capability, you must specify resource requirements.

The Enter or Modify Resource Requirements screen shown below, contains the fields used to establish
resource requirements.

The fields in the upper half of this screen — Activity Code, Description, Duration, Calendar #, and
Loading Estimate — are read-only fields. The first four of these fields display information entered on the
activity screen. The Loading Estimate is calculated by multiplying the resource quantity by its duration.

Once the program is baselined, you cannot access the Enter or Modify Resource Requirements screen.

The following is an explanation of the other fields on the Enter or Modify Resource Requirements screen.

Resource Code

Identifies a resource required to complete the activity. An entry is required in this field. Resource
specification and availability codes for the same resource should be identical to this code. CSS uses
this code when comparing the resource requirement with the resource specification and availability.

Enter a ? to display a pop-down menu listing the specified resources. To add a resource from this
menu, highlight the appropriate resource code and press < Enter >.
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You may also add a resource code by typing one in this field. If you try to add a code not listed in
the pop-down menu, this message is displayed:

WARNING: Resource code does not exist in the specifications table. Do you wish to add it?
No/Yes

If you do not want to add the resource code, highlight No with the cursor and press < Enter >. This
prompt is displayed:

ERROR: Invalid resource code. Press any key to re-enter.

Press any key. The cursor returns to the Resource Code field where you can make your correction.

If you want to add the resource code, highlight Yes with the cursor and press < Enter >. This prompt
is displayed:

Enter Resource Type: Labor/Material/ODC

Use the cursor to highlight the appropriate type and press < Enter >. If you have not entered data in
the mandatory field(s) for the resource type, you will be prompted to do so. See the explanation for
the Type field below.

After you have added a resource, this message is displayed:

WARNING: Resources have been added to the specifications table. Press any key to return.

Type

Specifies whether the resource involves labor, material, or ODC (other direct costs). If the resource is
listed in the pop-down menu for the Resource Code field, Type is a read-only field. If you are adding a
resource code, you must make an entry in the Type field as explained below.

For scheduling purposes, if the resource type is:

C labor, you must enter a value in the Quantity field but cannot access the Budgeted Cost
field

C material, you must enter values in the Quantity and Budgeted Cost fields

C ODC, you must enter a value in the Budgeted Cost field but cannot access the Quantity
field.
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The table below summarizes this information.

RESOURCE TYPE FIELD ACCESS

Labor

Material

ODC

Quantity          Budgeted Cost
    
     Y                      N
     
     Y                      Y

      N                     Y

Perhaps your program requires the rental of additional personal computers, which are material resources. In
the Quantity field you would enter the number needed (for example, 12). In the Budgeted Cost field you
would enter what you plan to spend, in total, for the PCs.

Quantity

Specifies the number of the labor or material resource(s) required per work period. To complete a
high-priority software development program, you might schedule the 12 extra PCs referred to
above. In addition, you could schedule, as labor resources, 12 day-shift program analysts and 12
night-shift program analysts.

Budgeted Cost

Specifies the cost associated with the material or ODC resource. It is the total planned cost for the
total quantity of material for that activity.

Duration

Specifies the length of time the resource is needed. This value is expressed as the number of
calendar work periods during which a resource is required. If you do not specify a value for
Duration, the value you entered in the activity duration field is used as the default. If you did not
enter a value in the activity duration field and CSS assigned the default value of zero, zero is also
assigned to the resource duration.

Delay

Specifies the delay period for the resource. This value is expressed as the number of work periods
between the activity start date and the resource start date. The default for the delay is zero.

The class and priority fields, following, are used together if you have more than one resource that could be
applied to the activity. For example, a program analyst might be able to help in writing software
documentation. For the activity of “Writing Chapter Seven,” you would assign the same class to the
technical writer and the program analyst. The technical writer, as the person with the primary writing skills,
would be assigned priority one. The program analyst would be assigned priority two. If the writer were not
available for the activity, the program analyst could be scheduled to complete the task.
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Class

Describes the general category to which the resource belongs.

Priority

Specifies the order in which a resource will be scheduled to fill the requirement. The lower the
priority number, the higher the priority given to the resource. The default value is zero (0), which
designates the highest priority. Using this field when you assign more than one resource to an
activity enables you to schedule alternate resources when a resource is not available.

Split Duration

Specifies the number of consecutive work periods this resource must be available. This field is
required if split scheduling is to occur. Split scheduling enables a resource to be scheduled in
nonconsecutive groups of work periods that total its required duration.

Maximum Splits

Specifies the maximum number of splits, or interruptions, that can occur during the scheduling
process. The default is null. This field is optional; it is used to limit the interruptions in the use of
this resource when an activity has resource availability conflicts. It ensures that a complex task is
not interrupted repeatedly because a resource is not available.

Calendar

Specifies the calendar CSS will use to calculate resource requirement dates for the resource. The
default calendar in this field is the activity calendar. Refer to chapter 4, “Defining the
Environment,” for information on calendars. It is recommended that program resource requirements
and availabilities be scheduled on the same calendar.

If you want to perform earned value analysis, do not use hourly and/or continuous calendars.

______________________________________________________________________________________
Constraints
______________________________________________________________________________________

Constraints (i.e., dependencies)specify the start and finish relationships among activities. They designate
activities that must be completed before others may start and activities that may run concurrently.
Constraints show the network logic.

When you select the Constraints option under Edit, one of two screens is displayed, depending on whether
your default network setting is Current Network or Extended Networks. This setting is selected under the
Setup option from the main menu and is described in chapter 10, “Performing System Administration.”
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______________________________________________________________________________________
Current Network

If your default network setting is the current network, the Enter or Modify Constraints screen is displayed as
shown below.

The Enter or Modify Constraints screen contains the fields used to establish a constraint in the current
network. This screen is also used to create a hammock, which is explained below.

Once the program is baselined, you cannot access the Enter or Modify Constraints screen. If changes are
required, they must be implemented through the What If option.

The following is an explanation of the fields on the Enter or Modify Constraints screen.

Preceding Activity

Identifies an activity that constrains another. An entry is required in this field.

Succeeding Activity

Specifies the activity that the preceding activity constrains. An entry is required in this field.
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Constraint Type

Specifies the dependency relationship between the activities. The five valid constraint types 
are fs (finish-to-start), ss (start-to-start), sf (start-to-finish), ff (finish-to-finish) or ham 
(hammock).

C Finish-to-start prevents the succeeding activity from starting until the preceding activity
finishes. This value is the default.

C Start-to-start prevents the succeeding activity from starting until the preceding activity has
started.

C Start-to-finish prevents the succeeding activity from finishing until the preceding activity has
started.

C Finish-to-finish prevents the succeeding activity from finishing until the preceding activity
finishes.

C Hammock specifies a constraint activity. A hammock spans the preceding and succeeding
activities and calculates the sum of the durations within the span.

Constraint Delay

Specifies the delay imposed on the start date or finish date of an activity. This value is expressed in
number of calendar work periods.

C A positive delay value postpones the start date of a constrained activity.

C A negative delay value moves up the start date of a constrained activity.

Calendar Number

Specifies the calendar CSS will use to calculate the delay for the constraints. Refer to Chapter 4,
“Defining the Environment,” for information on calendars.

If you want to perform earned value analysis, do not use hourly and/or continuous calendars.

Hammock Description

Identifies a group of activities spanned by a hammock constraint.
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______________________________________________________________________________________
Base Date and As of Date
______________________________________________________________________________________

The base date and as of date are used to monitor the progress of the program. When you select the Base
Date/As of Date option under Edit, the Enter or Modify Base Date/As of Date screen is displayed as shown
below.

The base date is the network's start date if no planned or actual dates are set. It can be entered only after a
network has been defined.

The base date is used during network analysis to compute activity start and finish dates. You must set the
base date before CSS can analyze and schedule the network activities.

If you enter actual progress dates, planned dates, or status dates that precede the base date, CSS accepts
your values but issues a warning message when you analyze or schedule the network.

Once the program has started, you can monitor progress against the as of date value. It reflects the most
recent date that changes were made in the network.

The status date of an individual activity overrides the as of date. If a status date has not been specified for
an activity, CSS sets the status date value equal to the as of date when actual dates are entered.

Activities that should have started but have not will have an early start date on or after the as of date.

After the network is baselined, you can enter information in the As of Date field only.
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________________________________
6  Performing Analysis________________________________
After you enter activity, resource, and constraint data including a base date, you can use the CSS
application to analyze the program network.

Network analysis enables you to determine if  your network is logical — that is, if the scheduled program
activities can occur in the specified order based on the constraints. If the network is not logical, you must
adjust the activity and constraint information until the network logic is correct. Analysis also provides the
projected completion date for the network, as well as the schedule information for each activity in the
network.

After the network is analyzed, you can:

C schedule and summarize the required resources to determine if there are enough resources available
to complete the program in the specified time

C summarize dates for individual WBS items, OBS elements, and resource actual hours

C perform earned value analysis to summarize program costs.
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The Process option on the CSS main menu enables you to perform analysis functions on your program
network. The options that perform these functions are listed below.

C Time Analysis — analyzes a network's scheduled activities only

C Resource Scheduling — based on resource availabilities, analyzes the resources required to
complete the network activities

C Resource Summarization — calculates data for reports and graphs that show the total amount of
resources required and available for a specific period

C Baselining — sets an original schedule for the network that can be used to monitor program
progress

C Loop Trace — traces network logic loops that may be present in your networks

C Library — allows for the storage of inactive networks for use at a later date

C OBS/WBS Schedule Rollup — summarizes network schedule dates at each OBS or WBS level
(Note: This feature is not available at this time).

C Actual Hours Summarization — determines the costs of and hours spent by resources.

C Earned Value Analysis — calculates planned, earned, and actual amounts and rolls up values for
the current period and cumulatively.(Note: This feature is not available at this time)

This chapter describes each of these options.

To select the networks on which to perform time analysis, resource scheduling, resource summarization, or
schedule rollups, refer to the “Default Settings” section in chapter 10, “Performing System Administration.”
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______________________________________________________________________________________
Time Analysis
______________________________________________________________________________________

Time analysis determines the schedule of your program network based on the activities and associated
constraints you have specified. It enables you to verify the internal logic of the network schedule.

When you select the Time Analysis option under Process, the screen shown below is displayed.

This prompt box is provided to ensure that the correct “As of Date” is being used. It is recommended that
the default of the current date be used.

During time analysis, the start dates, finish dates, and float values for each activity are calculated, and the
network's critical path is determined.

The start and finish dates are calculated based on the network's base date and as of date, the calendar(s)
specified for the network, and the activities' durations, delays, constraints, and actual dates.

Two types of float values are also calculated:

C Free float indicates the amount of time an activity's start date can be delayed without
affecting the start date of succeeding activities.

C Total float indicates the amount of time an activity's start date can be delayed without
affecting the program completion date. Float values are based on the activity's early and
late start dates.

The network critical path identifies activities that have zero total float and the path with the longest total
duration. These activities are important because they cannot be delayed without affecting the finish date of
the network. Activities not on the critical path can slip without affecting the finish date.
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While the network is being analyzed, the network base date and as of date, precedence network record
totals (number of activities and constraints of each type), beginning and ending activities, finish date, and
network logic errors (if any) are displayed on your computer screen.

If the analysis results in logic errors, the errors are listed. You will need to modify activity or constraint
information to correct the errors and then re-analyze the network.

The user also has the option of generating a more detailed status report is they wish. The report is shown

below:
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______________________________________________________________________________________
Baselining the Program
______________________________________________________________________________________

Baselining the program helps you monitor its progress. After a program is baselined, you can compare the
baselined — or original schedule — dates with the dates recalculated as a result of network updates. (If you
have more than one network for your program, the extended network is baselined.) You can compare
baselined and recalculated dates by analyzing reports and graphs.

This option is available only to users with administrator access.

When you select the Baselining option under Process, a pop-down menu is displayed with the options
Original, Revised, and Intermediate. These options are described below.

C The original baseline is the initial baseline schedule request for the program. It should be set only
once to provide a basis for evaluating progress and comparing alternatives.

C The revised baseline is a new network schedule based on approved changes to activities, constraints,
or resource data. For example, a revised baseline may be set upon approval of changes made
through the What If option. It can be set as many times as necessary to reflect the impacts of
network changes.

C The intermediate baseline provides a current network schedule for comparison against future
changes. The intermediate baseline can show how updates affect the schedule of a network already
in progress.

After you select a baseline type, another pop-down menu is displayed listing options to Create or Delete
the selected baseline. When you select one of these options, you are prompted to confirm creation or
deletion of the baseline, or to confirm that you want to overwrite the revised or intermediate baseline. To
recreate the original baseline, you must first delete it.

A message is displayed when baselining is complete.

______________________________________________________________________________________
Loop Trace
______________________________________________________________________________________

The Loop Trace function is a routine that will identify “loops” that have been created in a network.  CSS is
unable to Analyze a network that contains logic loops. If you attempt to analyze a network that contains
loops you will receive an error message to that effect.

A loop in a network is when an activity is tied logically back to itself. The network can not be developed in
this way.  

To run the Loop Trace function, simply click on the option under the Process menu and the function will
run for the current network.
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______________________________________________________________________________________
Library 
______________________________________________________________________________________

The CSS library contains copies of project templates or networks  that have been used on past construction
projects.

The user is presented with three option when clicking on the Library function:

C Mark job for shelving 

C Shelve Job

C Unshelve Job 

Mark job for shelving

The user may mark several networks for shelving. Click on the Mark Job for Shelving option to
mark a network.  You may then open and continue working in another network if you so desire.

Shelve Job

This function allows the user to shelve jobs that have been marked for shelving.  Click on the option
and list of marked for shelving jobs will be presented.  Click on Exit to continue the shelving
process.

Unshelve Job

This option allows the user to Unshelve networks that have been stored in the CSS library.  Click on
this option and select from the drop down list the network you would like to work with.
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___________________________________________
7 Generating Reports and Graphs___________________________________________

The CSS application includes the capability to produce reports and graphs generated from the program
management data entered and calculated within the application.

The Reports option (this was previously the View option under the Edit menu) on the CSS main menu
enables you to select listings, reports, and graphs for output to your screen or to a printer, plotter, remote
printer or plotter, or file. When you select the  Reports option on the CSS main menu bar, as shown below.
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The Reports menubar is displayed with the options: Admin, Program, and Network.

** Denotes option that are currently unavailable at this time

This page provides a summary indicating the various reports and graphs that can be generated under each
Reports menubar option.

ADMINISTRATION LISTINGS
1. Calendar Detail
2. Calendar Summary
3. Field Data Dictionary
4. Recordset Read/Write Access
5. User Access

PROGRAM REPORTS/GRAPHS
OBS Reports/Graphs
1. OBS Listing **
2. OBS Diagram **
WBS Reports/Graphs
3. WBS Listing **
4. WBS Diagram **
Program Audit Listings
5. Full Program
6. Network
7. Resource Availability Table**
8. Program Calendar

NETWORK REPORTS AND GRAPHS
Activity Reports/Graphs
1.  Activity Listing
2.  Activity Detail Listing
3.  Activity Gantt Chart
4.  Activity Schedule
5.  Activity Schedule Variance
6.  Activity Predecessor/Successor Listing 
7.  Constraints Listing
Hammock Reports/Graphs 
8.  Hammock Listing
9. Hammock Schedule
10. Hammock Gantt Chart
11. Network Logic Diagram
12. Progress Schedule Analysis
13. Progress Gantt Chart

This chapter describes how to generate reports and graphs. For specific information about and examples of
the available outputs, refer to the appendixes at the back of this manual.
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______________________________________________________________________________________
Administration Listings
______________________________________________________________________________________

The Administration Listings option enables you to produce listings of generic data used throughout the CSS
application.

When you select the Admin option from the Reports menubar, the following options are displayed:

C Calendar Detail (a pop-down menu displays the available calendar selections)

C Calendar Summary

C Field Data Dictionary

The Recordset Read/Write Access, and User Access administration listings are not available under
the What If option. However, the What If Administration Listings include these additional options:

C Recordset Read/Write Access

C User Access
______________________________________________________________________________________
Program Reports/Graphs
______________________________________________________________________________________

The Program Reports/Graphs option enables you to produce reports of the data you have entered within the
CSS application.

When you select the Program option from the Reports menubar, the following options are displayed:

C OBS Reports/Graphs **

This option provides a pop-down menu. Menu options are Listing and Diagram.

C WBS Reports/Graphs **

This option provides a pop-down menu. Menu options are Listing and Diagram.

C Program Audit Listings
This option provides a menu. Menu options are Full Program, Network, Resource
Availability Table, and Program Calendar.
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______________________________________________________________________________________
Network Reports/Graphs
______________________________________________________________________________________

The Network Reports/Graphs option enables you to produce reports on the scheduling of the data you have
analyzed with CSS.

When you select the Network option from the Reports menubar, the following options are displayed:

C Activity Reports/Graphs

This option provides a pop-down menu. Menu options are; Listing, Detail Listing, Gantt
Chart, Schedule, Schedule Variance, and Predecessor/Successor Listing, Constraint Listing

C Activity Listing

C Activity Detail Listing

C Activity Gantt Chart

C Activity Schedule

C Activity Schedule Variance

C Activity Predecessor/Successor Listing

C Constraints Listing

C Hammock Reports/Graphs

This option provides a pop-down menu. Menu options are Listing, Schedule, and Gantt
Chart.

C Hammock Listing

C Hammock Schedule

C Hammock Gantt Chart

C Network Logic Diagram

C Progress Schedule Analysis

C Progress Gantt Chart
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______________________________________________________________________________________
Data Entry Screens for Listings and Reports
______________________________________________________________________________________

After you select one of the following listings or reports, a screen is displayed for you to enter record
selection criteria. The listings and reports are categorized according to menu.

From the Admin option:

C Calendar Detail (a pop-down menu displays the available calendar selections)

C Calendar Summary

C Field Data Dictionary

C Recordset Read/Write Access

C User Access

From the Program option:

C OBS Reports/Graphs **

C WBS Reports/Graphs**

C Full Program

C Network

C Resource Availability Table**

C Program Calendar

From the Network option:

C Activity Listing

C Activity Detail Listing

C Activity Schedule Variance Report

C Activity Predecessor/Successor Listing

C Extended Network Activity Listing

C Hammock Listing.
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A representative data entry screen for these listings and reports is shown below.

The fields on this screen enable you to select the records you want to include in the listing or report. When
you access each field, one of the following is presented:

C A standard default value that cannot be modified

OR

C A pop-down menu that lists the selection criteria for the statement that has been established
by the application administrator.

Some of these pop-down menus are not displayed until you activate them. To activate this
type of menu, type any character in the appropriate field and then press < Enter >.   The
pop-down menu is displayed.

Users with administrator access can establish pop-down menus of criteria for these fields by
using the Macro Administration option described in chapter 10, “Performing System
Administration.”
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The following is an explanation of each of the fields on this screen.

Report Title

Describes the listing or report.

Group Statement

Specifies a condition for grouping records.

Where Statement

Specifies a condition for selecting specific records for output.

Order Statement

Specifies how the selected records should be sorted.

Several more reports have the same fields described above and additional baseline fields. These reports are
categorized by menu.

From the Program option:

C Actual Hours Tracking Report

C OBS Schedule Rollup

C WBS Schedule Rollup

From the Network option:

C Activity Schedule Report

C Hammock Schedule Report

C Progress Turn-Around Report.
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A representative data entry screen for these listings and reports is shown below.

The following is an explanation of the baseline fields on this screen.

Baselines

Specifies whether information on the original, revised, or intermediate baseline should be included.
Enter y in each field for which you want to include the baseline information.

For each of these fields, you can select an option from the pop-down menu if one is presented. To access
pop-down menus, place any letter in the data entry box and hit Enter.  After you select criteria in these
fields, click on:

C EXIT if you decide not to process the listing or report

OR

C UPDATE to process the listing.

The Destination pop-down menu enables you to specify the output destination.  This can be accessed by
Clicking on PRINT in the lower right hand side of the CSS report screen.

Select the appropriate destination printer and clcik OK.  Your report will be sent to the designated printer. 
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_____________________________________________________________________________________
Data Entry Screens for Graphs
_____________________________________________________________________________________

This section describes the screens used to generate the graphs provided in CSS.

_____________________________________________________________________________________
Gantt Charts

After you select one of the following graphs under the Network option, a screen is displayed for you to
enter record selection criteria:

C Activity Gantt Chart

C Hammock Gantt Chart

C Network Logic Diagram

C Progress Gantt Chart.

When you access each field, one of the following is presented:

C A standard default value that cannot be modified

OR

C A pop-down menu that lists the selection criteria for the statement that has been
established by the application administrator.

Some of these pop-down menus are not displayed until you activate them. To activate this type of menu,
type any character in the appropriate field and press < Enter >. The pop-down menu is displayed.

Users with administrator access can establish pop-down menus of criteria for these fields by using the
Macro Administration option described in chapter 10, “Performing System Administration.” 
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A representative data entry screen for these graphs is shown below. The fields on this screen enables you to
select the records you want to include in the graph. 

The following is an explanation of each of the fields on this screen.

Plotter
Specifies a CSS or remote plotter.

If the selected plotter has not been defined or is incorrectly assigned or configured, warning or error
messages are displayed. See chapter 10, “Performing System Administration,” and your system
administrator for more information.

Report Title
Describes the graph.

Group Statement
Specifies a condition for grouping records in the graph.

Where Statement
Specifies a condition for selecting specific records for output.

Order Statement
Specifies how the selected records should be sorted.

Report From/To Dates
Specify the date range for selecting records to be included in the graph.

When you select the Network Logic Diagram, this screen includes fields for selecting the diagram routing
(over rank or over time), but does not have the order and report from/to date fields.
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_____________________________
8 Using the What If Capability_____________________________
*** This capability is currently unavailable***

The CSS application includes a What If option that enables you to make changes to a copy of your program.

With the What If capability, you are working in a copy of the original program. You can continue working
with the original program while creating What If scenarios.

When using What If, you can modify the copied program by adding or revising resource specifications and
availabilities, activities and resource requirements, and constraints for current and extended networks. You
can then analyze the modifications and produce reports showing the results of the What If analysis.

A set of modifications can be stored as a network change request (NCR). You can store several different
sets of changes as separate NCRs and select among them for further modification and analysis.

When you determine that a group of changes specified in an NCR should be included in the original
network, you can select that NCR for implementation if you have administrator access. If you do not have
administrator access, this option is not available to you. When an NCR is implemented, the modified
network from the What If environment overwrites the original network environment. Please contact your
systems administrator if you need to load an NCR and are unable to do so.

The following options under File on the CSS main menu enable you to use the What If capability:

C Open

C New

C Delete.

You can open or delete a What If only if you have administrator access. There can be only one What If per
program.

When you select What If under Open, a prompt is displayed for you to verify that you want to create a
What If environment. Another prompt enables you to describe the What If. Press < Enter > to create the
What If environment.

If a What If environment already exists, you must verify that you want to overwrite the existing What If
environment. Enter y to do so. Be sure to implement any approved changes from the existing What If
environment before you create a new one.



8 - 2

CSS does not allow a user to delete a What If project while another user is in the project. When you select
What If under Delete, a prompt is displayed for you to verify deletion. Make sure there is no other user in
the What If project when you delete it.

Be aware that when you delete a What If, you also delete the corresponding NCRs.

When you select What If under Open or New, the What If menubar is displayed as shown below.

This chapter describes the options available from the What If menubar. Because several of the What If
options perform functions similar to those described in previous chapters of this manual, this chapter
describes the functions and fields that are unique to What If. Refer to the appropriate chapters for
information on the functions and fields not described in detail in this chapter.
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______________________________________________________________________________________
Defining the What If Environment
______________________________________________________________________________________

Several options under File on the What If menubar enable you to select a network and resource
availabilities to work in and initialize all, current, or selected What If recordsets. To initialize a recordset
means to make it identical to the original recordset on which it was based at the time the What If
environment was first created.

Use the Network Specification option under Open to choose the network in which you wish to work. The
selected network becomes the default network used for any data entry or processing until you select a
different network. If you do not select a network to work on within What If, the current network is
displayed as the default in the top center portion of the screen.

Use the Resource Availability Table option under Open to choose a resource availability table to work
with. The selected resource availability table becomes the default used for any data entry or processing until
you select a different resource availability table. If you do not select a resource availability table to work on
in What If area, the current resource availability table is displayed as the default in the top right portion of
the screen.

Use the Initialize What If option under New to select recordsets to initialize. When you choose this option,
a pop-down menu is displayed listing the following selections:

C All

C Current

C Selected.

When you select the first option, All Recordsets in What If, all recordsets are initialized. If you select the
second option, Current Recordsets, the network, resource specifications, and resource availability
recordsets you have selected for your current What If environment are initialized. In both cases, a message
is displayed when the initialization is complete.
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If you select the third option, Selected Recordsets, pop-down menus are displayed for you to select a
network and an availability table. If you want to initialize more than one network or resource availability
table, repeat the process from the Initialize What If option.

NOTE: When you reinitialize a What If environment, you reset it to the values shown in the Network
Value fields on the screens displayed in chapter 5, “Entering and Modifying Information.”

When you are using a What If, you will change some of the data entered for the original network to
determine the effects of the changes on the network.

The Edit option on the What If menubar provides selections enabling you to enter and modify What If data
for:

C resource specifications

C resource availabilities

C activities and resource requirements

C constraints.

Each of these options presents a screen you can use to enter or modify data for the What If. These screens
are similar to the screens used for entering or modifying data for the original program. The current data for
the original program is presented in read-only fields; you can enter or modify What If data in corresponding
fields adjacent to the fields for the original program data.

These options are described on the following pages. Information on the data entry fields unique to the
What If option is presented in this chapter; information on the other data entry fields is available in chapter
5, “Entering and Modifying Information.”
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_____________________________________________________________________________________
Resource Specifications

When you select Resource Specifications under the Edit option on the What If menubar, the Enter or
Modify What If Resource Specifications Screen is displayed as shown below. You can use this screen to
add or modify resource specification information for the What If.

The following is an explanation of some of the fields on the Enter or Modify What If Resource
Specifications screen. Refer to chapter 5, “Entering and Modifying Information,” for an explanation of the
other fields on this screen.

What If Description

Identifies and describes the What If resource.

Resource Description

Identifies and describes the original resource. This is a read-only field.

Flag resource for deletion

Designates the resource specification for deletion from the program. Enter y if you do not want to
include the resource specification in the What If. The resource specification is actually deleted from
the original program when the NCR for this resource  specification is implemented; until then it is
ignored for scheduling.
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When you finish entering resource specification information and have pressed < F6 > (to add) or < F7>(to
update), press < F9 > to access the subrecord. You can use the subrecord to add or modify resource rates
information for the What If.

The following is an explanation of one of the fields on the Enter or Modify What If Resource Specifications
subrecord. Refer to chapter 5, “Entering and Modifying Information,” for an explanation of the other fields
on this screen.

Flag resource rates for deletion

Designates the resource rates for deletion from the program. Enter y if you do not want to include
this resource rate in the What If. The resource rate is actually deleted from the original program
when the NCR containing this resource is implemented; until then  it is ignored for scheduling.

______________________________________________________________________________
Resource Availabilities

When you select Resource Availabilities under the Edit option on the What If menubar, the Enter or
Modify What If Resource Availabilities screen is displayed on the following page. You can use this screen
to add or modify resource availabilities in the What If environment.

The following is an explanation of one of the fields on the Enter or Modify What If Resource Availabilities
screen. Refer to chapter 5, “Entering and Modifying Information,” for an explanation of the other fields on
this screen.

Flag resource availability for deletion
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Designates the resource availability for deletion from the program. Enter y if you do not want to include the
resource availability in the What If. The resource availability is actually deleted from the original program
when the NCR for the resource availability is implemented; until then it is ignored for scheduling.

______________________________________________________________________________________
Activities and Resource Requirements

When you select Activities & Resource Requirements under the Edit option on the What If menubar, the
Enter or Modify What If Activities screen is displayed below. 

You can use this screen to add or modify activity information for the What If environment.

The following is an explanation of some of the fields on this screen. Refer to chapter 5, “Entering and
Modifying Information,” for an explanation of the other fields on this screen.

What If Description

Identifies and describes the What If activity.

Activity Description

Identifies and describes the original activity. This is a read-only field.



8 - 8

Flag activity for deletion

Marks the activity for removal from the network. Enter y if you do not want to include this
activity in the What If network. The activity is actually deleted from the original network when the
NCR containing this activity is implemented; until then it is ignored for scheduling.

You must flag for deletion constraints that include activities flagged for deletion.

When you finish entering and saving activity information, press < F9 > to display the Enter or Modify
What If Resource Requirements screen. You can use this screen to add or modify requirements information
for the What If. This screen is shown below.

The following is an explanation of one of the fields on the Enter or Modify What If Resource Requirements
screen. Refer to chapter 5, “Entering and Modifying Information,” for an explanation of the other fields on
this screen.

Flag resource requirement for deletion

Designates the resource requirement for deletion from the activity. Enter y if you do not want to
include this resource requirement in the What If activity. The resource requirement is actually
deleted from the original activity when the NCR containing this resource is implemented; until then
it is ignored for scheduling.
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_____________________________________________________________________________
Constraints

When you select Constraints under the Edit option on the What If menubar, one of two screens is
displayed for you to specify constraints for the What If network, depending on the default network setting.
The default network setting is chosen under the Setup option on the What If menubar; the choices are
Current Network and Extended Network.

If your default network setting is for the current network, the Enter or Modify What If Constraints screen is
displayed as shown below.

The following is an explanation of some of the fields on the Enter or Modify What If Constraints screen.
Refer to chapter 5, “Entering and Modifying Information,” for an explanation of the other fields on this
screen.

What If Hammock Description

Identifies and describes the What If hammock.

Network Hammock Description

Identifies and describes the original hammock. This is a read-only field.

Flag constraint for deletion
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Marks the constraint for removal from the network. Enter y if you do not want to include the
constraint in the What If environment. The constraint is actually deleted from the original
program when the NCR containing this constraint is implemented; until then it is ignored for
scheduling.

If your default network setting is for extended networks, the Extended What If Network Fields screen is
displayed as shown below. You can use this screen to join networks in What If.

The following is an explanation of one of the fields on the Extended What If Network Fields screen. Refer

to chapter 5, “Entering and Modifying Information,” for an explanation of the other fields on this screen.
Flag constraint for deletion

Marks the constraint for removal from the extended network. Enter y if you do not want to
include the constraint in the What If environment. The constraint is actually deleted from the
original program when the NCR containing this constraint is implemented; until then it is
ignored for scheduling.

______________________________________________________________________________________
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Performing Analysis
______________________________________________________________________________________

After you have made changes to the What If network, you can analyze the effects of the changes in the same
way as you did for the original network.

The Process option on the What If menubar presents the following options for performing analysis
functions on your What If network.

C Time Analysis — schedules the individual activities of a network with or without
resources

C Resource Scheduling — schedules the resources required to complete the network
activities depending upon the resource availabilities

C Resource Summarization — determines the total amount of resources required and
available for each period

C OBS/WBS Schedule Rollup — summarizes costs and hours spent at each OBS or
WBS level

C Actual Hours Summarization — determines the costs of and hours spent by
resources.

These options are similar to those available under Process for the original network. Refer to chapter 6,
“Performing Analysis,” for information on using these options.
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______________________________________________________________________________________
Working with NCRs
______________________________________________________________________________________

The What If option enables you to keep track of the various changes you make to your program. You can
specify an NCR as a single change or a group of changes for a particular network. Although the number of
changes depends on the program and user, the What If environment can save and organize an unlimited
number of change requests for later reference.

The What If option uses NCRs to maintain a detailed history of actual and proposed changes to the
program. You cannot make permanent changes to the program until the NCR corresponding to those
changes has been stored. By using NCRs, you can store requested changes separately until you want the
changes actually implemented in the program.

The following options under File on the What If menubar are used to work with NCRs:

C Save NCR

C Open (Network Change Request)

C Delete NCR.

These options are described on the following pages.

______________________________________________________________________________________
Storing Current Changes

After you have made changes to the What If environment using the Edit options and have analyzed the
What If network using the Process options, you should store the changes as an NCR.

This function is central to the What If capability because it enables you to create and store different change
scenarios for the network. You can retrieve and compare the different scenarios to determine which of them
should be implemented in the original network.

When you select Save NCR under File, the Store Changes as a Network Change Request screen is
displayed as shown on the next page.
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CSS automatically assigns a number to the NCR. The next sequential number available for the current
What If network's NCR is displayed in the NCR Number field.

Use the Change Description field to describe the changes made to the What If network for this NCR.

When you store the NCR changes, you can use the Reinitialize What If  prompt to either remove the
changes from or retain the changes in the What If network. By retaining the changes, you can develop
another NCR that builds on the changes without having to re-enter them.

C To remove the changes from the What If network, enter y at the prompt to reinitialize
the network.

The changes will be stored for the NCR, but they will no longer be included in the
What If network.

C To retain the changes in the What If network, enter n at the prompt.

The changes you are storing for this NCR will continue to be included in the 
What If network.

Press < F6 > to add the changes or < F1 > to exit without storing.

You can use the Select option to retrieve stored NCRs and include them in the What If network at a later
time.
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______________________________________________________________________________________
Selecting an NCR

You can select specific NCRs to apply to your What If for evaluating various What If scenarios.

When you choose Select NCR under Open, a list of existing NCRs is displayed. Select the desired NCR for
the What If.

If you did not reinitialize the What If back to its original status when you last stored an NCR — that is, if
the What If network is not identical to the original network — the following prompt is displayed:

WARNING: Changes have been made to the What If since it last was stored. Do you wish to
OVERWRITE the resident NCR with the selected NCR? (n):

Press < Enter > if you want only the resident NCR to be reflected in your What If network; the NCR you
selected will not be included. Enter y to replace the current NCR with the selected NCR.

______________________________________________________________________________________
Deleting an NCR

When an NCR no longer applies to your What If, you can delete it from the What If environment.

When you select Delete NCR under File, a list of existing NCRs is displayed. Use the arrow keys to
highlight the desired NCR and press < Enter > to select it. The following prompt is displayed:

Are you sure you wish to DELETE NCR '<number>'? (n):

Enter y to delete the NCR and restore the What If network to its original configuration. Press < Enter > if
you do not want to remove the NCR.

______________________________________________________________________________________
Implementing Network Changes
______________________________________________________________________________________

Implementation is the final stage of What If analysis. During implementation, the changes associated with a
particular NCR overwrite the original network.

The Implementation option is available only to users with administrator access. In a multi-user
environment, configuration management procedures should be in place to ensure that NCRs are properly
implemented.

After you have analyzed the What If network and are satisfied with the results of the network changes, you
can implement the changes into the original network.
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The Implement NCR option under New enables you to implement changes stored in an NCR into the
original network. When you select this option, a pop-down menu listing the existing NCRs is displayed.
Select the NCR you want to implement. The following prompt is displayed:

Are you sure you wish to IMPLEMENT NCR 'number'? (n):

Enter y to implement the NCR, or press < Enter > if you decide not to implement the NCR.

When implementation is complete, obsolete NCRs are deleted. The following message is mailed to all users
with What If access:

What If NCR has been implemented '<date and time>'.

Use the Initialize What If option under New as described above to initialize the What If network. A new
What If environment is established to ensure that the original network and the What If network are
identical.

After you implement the NCR, you should reanalyze the original network.

______________________________________________________________________________________
Generating Reports and Graphs
______________________________________________________________________________________

The What If option includes the capability to produce reports and graphs generated from program
management data entered and calculated in CSS. Many of the reports produced through the What If option
provide comparable information on the original network and its corresponding What If network, enabling
you to assess the impact of the What If scenario you established.

The listings, reports, and graphs can be output to your terminal screen, a printer, plotter, or file.

The View option on the What If menubar presents a pop-down menu with the following options:

C Administration Listings

C Program Reports/Graphs

C Network Reports/Graphs

C Resource Reports/Graphs.

When you select any of these options, another pop-down menu is displayed containing specific listings,
reports, and graphs for the type of output selected. The outputs available in the What If option are listed on
the following pages.

Refer to chapter 7, “Generating Reports and Graphs,” for more information on producing these outputs.
Refer to the appendixes for examples of the listings, reports, and graphs.
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______________________________________________________________________________________
Administration Listings

When you select Administration Listings under Reports, the following options are displayed:

C Calendar Detail

C Calendar Summary

C Field Data Dictionary

C Field Header & Format

C Network Change Request Audit Trail

C Network Change Request Summary.

The Program Audit, Recordset Read/Write Access, and User Access administration listings are not
available through the What If option.

______________________________________________________________________________________
Program Reports/Graphs

When you select Program Reports under Reports, the following options are displayed:

C Actual Hours Accounting Listing

C Actual Hours Status Graph

C Actual Hours Summarization

C OBS Listing

C OBS Diagram

C OBS Schedule Gantt Chart

C WBS Listing

C WBS Diagram

C WBS Schedule Gantt Chart

C OBS/WBS Schedule Rollup.

The Actual Hours Tracking and Earned Value program reports are not available through the What If option.
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______________________________________________________________________________________
Network Reports/Graphs

When you select Network Reports under View, the following options are displayed:
Activity Listing

C Activity Detail Listing

C Activity Gantt Chart

C Activity Schedule

C Activity Schedule Variance

C Activity Predecessor/Successor

C Extended Network Listing

C Hammock Listing

C Hammock Schedule

C Hammock Gantt Chart

C Network Logic Diagram

C Progress Gantt Chart.

______________________________________________________________________________________
Resource Reports/Graphs

When you select Resource Reports under View, the following options are displayed:

C Resource Availabilities Listing

C Resource Forecast Graph

C Resource Specifications Listing

C Resource Requirements Listing

C Resource Schedule

C Resource Summarization.
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______________________________________________________________________________________
Additional Options
______________________________________________________________________________________

The Options and Setup selections on the What If menubar enable you to use several other functions
available under the main menu in the What If environment.

The Display User Environment selection under Options is described in chapter 9, “Using the System
Utilities.” The Default Entry Settings, Default Network Settings, and Default Rollup Settings selections
under Setup are described in chapter 10, “Performing System Administration.”
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________________________________
9 Using the System Utilities________________________________
The CSS application includes system utilities to provide you with information about your working
environment, make changes to it, and import and export data files

The Options selection on the CSS main menu enables you to control and customize your working
environment and communicate with other applications. The selections under Options are listed below.

C Current User Environment — displays information about your current environment

C System Utilities — provides system functions to display the status of the output
spooler, printers, and plotters; display system user and directory listings.

C Export Utility — enables CSS data to be sent out for use with other applications

C Import Utility — enables data files from other applications to be loaded into CSS
recordsets

C Macro Utilities — enables you to customize data entry screens, gantt charts, logic
diagrams, and reports.

This chapter describes each of these selections.
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______________________________________________________________________________________
Current User Environment
______________________________________________________________________________________

The Current User Environment selection under Options enables you to display information about the
user environment. When you select this option, the screen shown below is displayed.

The following is an explanation of each of the fields on this screen. All fields are read-only; you cannot
modify any of these fields from this screen. The upper right corner of the screen displays the version of
CSS you are working with.

Login Name

Displays your login ID.

Administration Access

Indicates whether you have access to the options reserved for the application administrator by
displaying y – yes or n – no.

CAT Access

Indicates whether you have access to the CAT system prompt by displaying y – yes or n – no.

What If Access

Indicates whether you have access to the What If environment by displaying y – yes or n – no.
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Active Recordsets and Access Restrictions

These fields display the name and description of the network and availability table you have
selected and indicate whether you have read or write permission for the network and availability
table by displaying y – yes or n – no.

WBS Relationship

If a WBS has been created, the relationship assigned among the WBS elements is displayed. Valid
values for this field are Standard (no trailing period), Standard (trailing period), and Parent.

OBS Relationship

If an OBS has been created, the relationship assigned among the OBS elements is displayed. Valid
values for this field are Standard (no trailing period), Standard (trailing period), and Parent.

Program Baselines

Indicates if baselines have been established for the current program by displaying y – yes or n – no.
The available baselines are the original baseline, the revised baseline, and the intermediate baseline.
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______________________________________________________________________________________
System Utilities
______________________________________________________________________________________

The System Utilities selection under Options enables you to use CAT system utilities to check system
status.

The following selections are listed under the System Utilities option:

C Display Spooler Status

C Display Printer Status

C Display Plotter Status

C Display User Status

C Display Directory Listing

Use the arrow keys to highlight the desired option and press < Enter >. The pop-down menu options are
described below.

______________________________________________________________________________________
Display Spooler Status

When you select this option, the status of each of the available spoolers for output devices (printers and
plotters) is displayed. The first line specifies whether the scheduler, which queues print jobs, is running.
The information listed for each output device includes the device name, whether the device is idle or
running, and the last date the device was enabled or disabled.
______________________________________________________________________________________
Display Printer Status

When you select this option, the status of each of the available printers is displayed. The first line specifies
whether the scheduler, which queues print jobs, is running. The information listed for each printer includes
the printer's device name, whether the printer is idle or running, and the last date the printer was enabled or
disabled.
______________________________________________________________________________________
Display Plotter Status

When you select this option, the status of each of the available plotters is displayed. The first line specifies
whether the scheduler, which queues print jobs, is running. The information listed for each plotter includes
the plotter's device name, whether the plotter is idle or running, and the last date the plotter was enabled or
disabled.
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______________________________________________________________________________________
Display User Status

When you select this option, a listing of all current system users is displayed. The information for each user
includes the user's login name, terminal name, project access mode (READ, WRITE, or MULTI), and the
full name of the project the user is currently accessing.

______________________________________________________________________________________
Directory Listing

This option enables you to display a listing of the files in your project directory. When you select this
option, the following prompt is displayed:

Enter directory or q to quit:

The current directory is given in parentheses as the default. Enter the full path-name of another directory, or
press < Enter > to accept the default.

A listing of all files contained in the specified directory is displayed.
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______________________________________________________________________________________ 
Export Utility
______________________________________________________________________________________

The Export Utility selection under Options enables you to send (export) formatted data from your current
project to the external operating system for use in other software programs or CAT applications. 

Two data formats are available: CAT export files from CSS or other CAT applications, or “flat” (ASCII
text) files to other software programs.

When you select this option, the Export Utility Information screen is displayed as shown below.

The following is an explanation of the fields on the Export Utility Information screen.

From Recordset

Specifies the name of the recordset from which data is being copied.

Include Definition
Indicates whether you want the recordset definitions associated with the exported data included by
entering y – yes or n – no. This field applies only if you use the CAT format.

Destination File

Specifies the name of the file that is to receive the data. You can append an extension such as 
.exp to the name to differentiate export files from other files. You must also include the directory
path where you want the files to be stored.
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File Format

Specifies the file format. The two formats are F and C.

C F — Flat file format (ASCII text) for use with other software programs

If you select F, you must specify the field names to be exported and their output 
lengths. Press < F6 > to access the lower portion of the screen. Enter the names of the fields
to be exported and the desired output lengths in the areas provided.

C C — CAT export file format for use with other CAT applications.
Press < F1 > when you have finished.

______________________________________________________________________________________
Import Utility
______________________________________________________________________________________

The Import Utility selection under Options enables you to receive (import) formatted data files from the
external operating system into your current project. Imported data from other software programs or CAT
applications is automatically loaded into a defined recordset. You can import data from other applications
for use in your project.

When you select this option, the Import Format pop-down menu is displayed, listing Standard Media
Format, CAT Data, SQL/Oracle Data and MPX Import.

______________________________________________________________________________________
Standard Media Format

#########Have to insert documentation for this section.###########
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______________________________________________________________________________________
CAT Data

If you choose the CAT Data option, the Import Utility Information screen is displayed as shown below.

Two data formats are available: CAT export files from CSS or other CAT applications, or “flat” (ASCII
text) files from other software programs. You cannot access this option after the program is baselined.

The following is an explanation of fields on the Import Utility Information screen.

File Name

Specifies the name of the file from which data is being imported.

File Format

Specifies the file format. The two formats are F and C.

C F — Flat file format (ASCII text) for use with other software programs

If you select F, you must specify the field names to be exported and their output lengths. Press
< F6 > to access the lower portion of the screen. Enter the names of the fields to be exported and the
desired output lengths in the areas provided.

C C — CAT export file format for use with other CAT applications.
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Destination Recordset

Specifies the name of the recordset that is to receive the data.

Overwrite/Append

Specifies whether the imported data replaces or is added to the current data in the recordset. Valid
values for this field are O – overwrite or A – append.

Press < F1 > when you have finished.

______________________________________________________________________________________
SQL/Oracle Data

If you want to export data from an Oracle database, choose the SQL/Oracle Data option. This prompt is
displayed:

Enter filename containing SQL commands and data:

Enter the appropriate SQL filename. This file must contain only data and CAT-supported SQL commands
from an Oracle database. (Refer to the chapter on SQL commands in the CAT Reference Topics manual.)

You must have first created the destination CAT recordset for the imported data or the recordset must
already exist in CAT.

After you enter the filename, this prompt is displayed:

File successfully loaded. Press any key to return.

Press any key. The cursor returns to the Utilities menu.

______________________________________________________________________________________
MPX Import

This option allows the user to import Microsoft Project MPX files. 
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______________________________________________________________________________________
Macro Utilities
______________________________________________________________________________________

The Macro Utilities selection under Options enables you to customize data entry screens, gantt charts,
logic diagrams, and reports to meet your specific data entry and reporting requirements. Any user who has
been granted access to a given network can access macros created by users in that network.

When you select this option, a pop-down menu is displayed with options for Data Entry, Gantts, Route,
and Reports. When you select any of these options, another pop-down menu is displayed, listing options to
Create, Delete, Duplicate, Modify, and Run a macro of the selected type.

C The Create and Modify options access screens for you to enter or change information
about a particular macro. These screens are described in the remainder of this chapter.
When you select the Modify option, a pop-down menu is displayed listing the macros
for you to select.

C The Duplicate option enables you to create a copy of a macro that you can then
modify. When you select this option, a pop-down menu is displayed listing the macros.
After you select a macro, a prompt is displayed for you to enter a unique name for the
new macro.

C The Delete option enables you to delete a macro. When you select this option, a
pop-down menu is displayed listing the macros. After you select a macro, a prompt is
displayed for you to confirm deletion.

C The Run option enables you to execute any of the macros you have defined. When you
select this option, a pop-down menu is displayed listing the macros for you to select.

If you select a data entry macro, the data entry screen is displayed. You can enter data using the
same procedures as for predefined data entry screens.

If you select a gantt chart, logic diagram, or report macro, the output is generated and a
pop-down menu is displayed for you to choose a destination for the output (Screen, Printer,
Remote Printer, or File).

The remainder of this chapter describes the screens used to create or modify macro definitions for each of
the four macro types.
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______________________________________________________________________________________
Macro Data Entry

 ***The customized data entry screen option is currently unavailable. ***

The utility for data entry macros enables you to use the CAT Screenpainter to define a screen for entering
data in a recordset you specify. (You must have administrator access to the recordset.) When you create a
data entry screen with the Screenpainter, you can include the fields you require for data entry and arrange
the fields in the order of your preference.

You cannot access this option after the program is baselined.

To customize a data entry screen, select the Data Entry option under Macro Utilities. After you select the
Create or Modify options from the pop-down menu, a screen is displayed similar to the one shown below.

The following is an explanation of each of the fields on this screen.

Data Entry Name

Specifies the name of the data entry macro. An entry is required in this field.

Entry From Recordset

Specifies the name of the recordset for which you are creating the data entry screen. An entry is r
equired in this field; it must be the name of an existing recordset.
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Entry Title

Describes the purpose of the data entry macro.

Where Statement

Specifies a condition for selecting records using the CAT WHERE command. Only those records
that meet the specified condition are made available for data entry using this macro. Do not use the
word “where” in this field; it is already included.

Refer to Appendix F, “Macro Reference,” for information on developing conditions for WHERE
statements.

Order Statement

Specifies which fields should be used to sort records using the CAT ORDER command. Records
available for data entry using this macro are sorted according to the specified criteria. Do not use
the word “order” in this field; it is already included.

Numerals in fields of the ALPHA, STRING, or TEXT types are sorted with respect to character
position rather than mathematical value; for example, 1, 10, 102, 2, 23, 35. Numerals in DECIMAL
or INTEGER fields are sorted by value.

You can specify REVERSE before a field name to sort its values from highest to lowest. Use
REVERSE preceding each field you want sorted in reverse order in the ORDER statement.

When you have finished entering the information for the data entry macro, press < F6 > (when
creating a macro) or < F7 > (when modifying a macro).

If the macro is valid, the CAT Screenpainter is accessed. Refer to Appendix F, “Macro Reference,”
for details on using Screenpainter. < Ctrl-A > provides a list of the keys and key combinations that
can be used for editing a data entry screen in Screenpainter.

When you have finished designing the screen, press < F7 > to save it, then press < F1 > to exit. The
Macro Utilities menu is redisplayed.

To use the screen for data entry, select the Data Entry option from the Macro Utilities pop-down
menu, then the Run option on the pop-down menu, and then the macro name from the next
pop-down menu.
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_______________________________________________________________________________
Macro Gantts

The utility for gantt chart macros enables you to define a gantt chart for your specific requirements.
You can specify conditions for selecting records, graphic definitions to be included, and plotter pen
colors.

To customize a gantt chart, select the Gantts option under Macro Utilities. After you select the
Create or Modify options from the pop-down menu, the first of two screens is displayed similar to
the one shown below.

The following is an explanation of each of the fields on this screen.

Report Name

Specifies the name of the gantt chart macro. An entry is required in this field.

Report From Recordset

Specifies the name of the recordset providing data for the gantt chart macro. The current
recordset displays and can be changed. An entry is required in this field; it must be the name
of an existing recordset.

Report Title

Describes the purpose of the gantt chart macro.
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Where Statement

Specifies a condition for selecting records using the CAT WHERE command. Only those
records that meet the specified condition are made available for this gantt chart macro. Do
not use the word “where” in this field; it is already included.

Order Statement

Specifies which fields should be used to sort records using the CAT ORDER command.
Records available for this gantt chart macro are sorted according to the specified criteria. Do
not use the word “order” in this field; it is already included.

Numerals in fields of the ALPHA, STRING, or TEXT types are sorted with respect to 
character position rather than mathematical value; for example, 1, 10, 102, 2, 23, 35. 
Numerals in DECIMAL or INTEGER fields are sorted by value.

You can specify REVERSE before a field name to sort its values from highest to lowest.
Use REVERSE preceding each field you want sorted in reverse order in the ORDER
statement.

Group Statement

Specifies a field on which to aggregate records for output. Records having identical values
for the specified field are grouped together for output using this gantt chart macro.  Do not
use the word “group” in this field; it is already included.

Detail Statement

Specifies the fields to be output in the description and header sections of the gantt chart 
macro. The items specified identify the values charted in the data section. Do not use the
word “detail” in this field; it is already included.

Start Date

Specifies the date to begin the gantt chart macro. Records with earlier dates are not selected.
An entry is required in this field.

Finish Date

Specifies the date to end the gantt chart macro. Records with later dates are not selected. An
entry is required in this field.

Major Ticks

Specifies a time interval for calendar scale divisions on the gantt chart macro. Small 
vertical marks are output at each time interval and labeled accordingly.
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Minor Ticks

Specifies a time interval for calendar scale divisions below the Major Ticks divisions 
on the gantt chart macro.

When you have finished entering information on the screen, press < Ctrl-N >. A second screen is
displayed similar to the one shown below.

The options on this screen enable you to specify graphic definitions and corresponding plotter pen
colors for the gantt chart macro. You can select any of the following graphic definitions:

C Original Baseline

C Revised Baseline

C Intermediate Baseline

C Current Schedule

C Current Float

C Actual Schedule

C Highlight Critical Activities

C Highlight Milestones.

You must specify at least one graphic definition by entering y in the corresponding field.



9 - 16

Default plotter pen colors are provided for each definition; you can change the colors if you wish.
Colors are specified by number. See your system administrator for information on the available
colors and corresponding numbers.

When you have finished entering the information for the gantt chart macro, press < F6 > (when
creating a macro) or < F7> (when modifying a macro).

To output the gantt chart, select Gantts under Macro Utilities, then the Run option on the
pop-down menu, and then the macro name from the next pop-down menu.
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_______________________________________________________________________________
Macro Logic Diagrams

The utility for logic diagram macros enables you to define a logic diagram for your specific
requirements.The utility for logic diagram macros enables you to define a logic diagram for your
specific requirements. You can specify conditions for selecting records, a box definition, and
routing information.

To customize a logic diagram, select Route under Macro Utilities. After you select the Create or
Modify options from the pop-down menu, a screen is displayed similar to the one shown below.

The following is an explanation of each of the fields on this screen.

Report Name

Specifies the name of the logic diagram macro. An entry is required in this field.

Report From Recordset

Specifies the name of the recordset providing data for the logic diagram macro. An 
entry is required in this field; it must be the name of an existing recordset.

Detail Statement

Specifies the fields to be output in the activity boxes of the logic diagram macro. Do 
not use the word “detail” in this field; it is already included.
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Box Length

Specifies the vertical size of the activity boxes in number of characters.

Box Width

Specifies the horizontal size of the activity boxes in number of characters.

Color

Identifies, by number, the color used to draw the critical path. See your system 
administrator for information on the available colors and corresponding numbers.

Float Level

Specifies the maximum float value an activity can have to be included in the critical 
path.

Route Rank

Indicates how the selected activities are routed on the logic diagram. When you access 
this field, a pop-down menu is presented with the following choices:

C Over Rank determines the positions of activity boxes on the network plot according to
the logical structure of the network.

C Over Time positions activity boxes relative to other activity boxes by start and finish
date values. Over time can produce a network plot with a very long horizontal axis.

Field Name

Specifies the date field in the recordset used to order the activities for routing over 
time.

Logic Diagram Title

Describes the purpose of the logic diagram macro.

Where Statement

Specifies a condition for selecting records using the CAT WHERE command. Only 
those records that meet the specified condition are made available for this logic diagram 
macro. Do not use the word “where” in this field; it is already included.

Refer to Appendix F, “Macro Reference,” for information on developing conditions 
for WHERE statements.
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Group Statement

Specifies a field on which to aggregate records for output. Records having identical 
values in the specified field are grouped together for output with this logic diagram 
macro. All activities with the same field values are placed in the same logic diagram 
row(s). Do not use the word “group” in this field; it is already included.

When you have finished entering the information for the logic diagram macro, press < F6 > (when
creating a macro) or < F7 > (when modifying a macro).

To output the logic diagram, select Route under Macro Utilities, then the Run option on the
pop-down menu, and then the macro name from the next pop-down menu.
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______________________________________________________________________________
Macro Reports

The utility for report macros enables you to define a schedule report for your specific requirements.
You can specify conditions for selecting records and the data to be output.

To customize a report, select Reports under Macro Utilities. After you select the Create or Modify
options from the pop-down menu, a screen is displayed similar to the one shown below.

The following is an explanation of each of the fields on this screen.

Report Name

Specifies the name of the report macro. An entry is required in this field.

Report From Recordset

Specifies the name of the recordset providing data for the report macro. An entry is 
required in this field; it must be the name of an existing recordset.

Report With Recordsets

Specifies the name of any linked recordsets providing data for the report macro.

Report Title

Describes the purpose of the report macro.
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Where Statement

Specifies a condition for selecting records using the CAT WHERE command. Only 
those records that meet the specified condition are made available for this report macro. Do
not use the word “where” in this field; it is already included.

Refer to Appendix F, “Macro Reference,” for information on developing conditions 
for WHERE statements.

Order Statement

Specifies which fields should be used to sort records  using the CAT ORDER 
command. Records available for this report macro are sorted according to the specified 
criteria. Do not use the word “order” in this field; it is already included.

Numerals in fields of the ALPHA, STRING, or TEXT types are sorted with respect to 
character position rather than mathematical value; for example, 1, 10, 102, 2, 23, 35. 
Numerals in DECIMAL or INTEGER fields are sorted by value. You can specify
REVERSE before a field name to sort its values from highest to lowest. Use REVERSE
preceding each field you want sorted in reverse order in the ORDER statement.

Group Statement

Specifies a field on which to aggregate records for output. Records having identical 
values in the specified field are grouped together for output with this report macro. Do 
not use the word “group” in this field; it is already included.

Detail Statement

Specifies the fields to be output in the report macro. Entry of at least one valid field 
name is required for this field. Do not use the word “detail” in this field; it is already 
included.

When you have finished entering the information for the report macro, press < F6 > (when creating
a macro) or < F7 > (when modifying a macro).

To output the report, select Reports under Macro Utilities, then select the Run option on the
pop-down menu, then select the macro name from the next pop-down menu.


